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About This Document

The User Guide contains the following chapters:

• 1-Introduction is an overview of the main operational features.

• 2-Preparation describes preparing and mounting originals on the scanner.

• 3-Tools & Palettes describes the user interface, including tools for controlling the 
foreground/background operations and tools for defining and editing an image.

• 4-Basic Scan introduces the basic scanning procedure for 16-bit DT files and for 
8-bit CMYK/RGB files using ICC profiles.

• 5-DT Files in oXYgen Scan and Open introduces the new working environment 
of a split workflow, and the scanning procedure for opening DT files for editing, 
including setup and preview options, and for performing final scans.

• 6-Color Management describes different ICC workflows the scanning 
applications support, and opening and viewing scanned images in Photoshop.

• 7-Tone Reproduction includes End Points, for defining the effective density range 
and removing color cast, and Gradation, for further tonal adjustment and color 
balance.

• 8-Color Editing describes the color functions. Color Correction for HSL/CMYK 
Selective and Global changes; LS Curves for color corrections by modifying the 
luminance and saturation values; Color Correction Mask; Gray Control to modify 
the grays; Input Gray Levels to modify the RGB input values, and the Separation 
setup functions.

• 9-Sharpness describes the Sharpness function, editing the Sharpness controls 
and performing max detail prescan.

• 10-Special Workflows describes the scanning procedures used for special 
purposes and for originals other than color transparency, for example, 8-bit/16-
bit direct scan, 16-bit B/W Mode, negatives, printed material, line-art, and 
optional procedures, such as Dot and scanning using the Oil Mounting kit.

• 11-Setup describes setup options and operation mode preferences, such as tone 
reproduction, densitometer and final file formats.

The Image Correction Examples booklet (Catalog No. 399Z50389A) illustrates the 
main functionality of the application in full color images. Throughout this user guide, 
specific references are given to relevant images in the booklet.
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Overview

This chapter provides: 

• Description of main operational features

The scanners are tabletop scanners for producing high quality color separations. 
The scanners are designed for maximum input flexibility, including:

• All types of originals: color transparencies and reflectives, positives, negatives, 
black and white, line-art and Glass-plate.

• High-resolution line-art scan, required for printers, packaging and Kanji script 
applications.

• A moiré elimination feature allows scanning printed material.

• Original size ranges from 35 mm up to 305 x 432 mm/
12 in. x 17 in. or 13 in. x 18 in. (only in IQ3).

• Unlimited thickness of reflectives and up to 5 mm (3/16 in.) thickness of 
transparencies.

The oXYgen Scan application is for scanning and saving images in either 8-bit RGB/
CMYK or 16-bit RGB file with full ICC color management workflow capabilities. The 
oXYgen Open application introduces a new working environment of a split workflow 
that enables processing of DT files created by the oXYgen Scan application. A 16-bit 
image file can be opened in the oXYgen Open application for repurposing at any time 
from its location on a disk, or it can be retrieved from an FTP site (if sent from 
remote). This can be done offline without scanner or the celluloid transparency.

The scanning applications provide the user with professional editing tools essential 
for achieving top image quality and for repurposing the image for any need. The split 
workflow breaks the one-on-one connection between the scanner and the operator. 
You can have one scanner scanning at night shift and several color experts doing the 
processing later. Alternatively, you can have several scanners scanning high quality 
images, and one expert doing the processing.

oXYgen Open is available on a seat license basis, protected with a software access 
key. Customers requiring the oXYgen Open application can purchase one or more 
site licenses.
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Main Features
The main application features are listed below.

Mounting originals

Originals can be mounted directly in the scanner, via specially designed masks, or 
using the optional oil mounting kit. A special slide holder is available for 35mm 
slides.

User interface

The multi-level user interface offers various tools for image editing, application 
control and preference setups. At the most basic level, an automatic workflow is 
possible, including cropping, selection of suitable tables and scanning. A more 
advanced level offers basic image editing, including color correction and sharpness 
tools. 

The user interface includes elements such as Layout display for defining the scan 
area before preview, Image display window for interactive image editing, Preview 
Browser for controlling the operation stage, Queue Manager and palettes for 
selecting functions.

16-bit scan in DT mode

A DT (Digital Transparency) file is an exact reproduction of the original in a digital 
format. It enables you to scan the image once at the maximum quality, and save it as 
a 16-bit DT file that contains all the information in the original. You can later open the 
DT file offline for repurposing. Scanning files as 16-bit DT files is important when the 
final output device is not yet known.

ICC workflows

The scanning applications fully support the ICC workflows giving you better control 
over the quality of scanned images. The ICC workflows can be used with transparent 
positive RGB/CMYK images and with reflective RGB/CMYK images. When 
scanning with ICC workflows, you can use either input/output profiles or device link 
profiles. The scanning applications offer several ICC workflows to suit your scanning 
needs.

Direct Scan

Direct Scan allows you to define all the scanning parameters for a batch of images 
without performing preview or crop prescan, and send the images directly to scan.

Background/foreground operation

Image editing, including sharpness editing of max detail, may be performed in the 
foreground. At the same time, the scanner performs background prescans, max 
detail and final scans. The application handles a queue for the background 
operations, shown in the Scanner Queue window.
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Multi-preview

To enhance scanner efficiency and productivity, several originals may be mounted, 
edited and scanned in a single run. Image editing can be done in the foreground, 
while other originals are processed in the background.

Multi-crop

Multi-crop enables defining and editing many crops on a single image. Each crop 
can be edited and prescanned separately.

Main editing functions

• Tone Reproduction functions for editing the tonal range of the image.

• Color Correction enables intuitive HSL as well as CMYK color corrections. The 
range of colors to be affected by your changes may be controlled.

• LS Curves enable you to perform color corrections in an image by modifying the 
luminance and the saturation values of a selected color. 

• Interactive sharpness editing on the max detail image (in final scan resolution) 
saves post-processing and rescanning time.

Tools when editing preview

• Image update when applying changes in interactive functions.

• Color Correction Mask gives you control over the exact pixels in the image on 
which you want to make color corrections. It is convenient for interactive editing 
in allowing you to see the color corrections on the preview immediately, before 
applying the changes.

• Split screen to compare the before/after display after image update.

• Floating densitometer to measure the color at the pointer’s position on the 
image.

• Sample points for measuring sample points.

• (ICC) Soft Proofing enables you to see on the screen what the image will look 
like when you use different ICC output profiles matching different output 
devices.

Output formats

The high-resolution final scan file is stored on the computer hard disk or scanned 
directly to a server. A wide range of file formats is available, such as TIFF for 16-bit 
files, TIFF, EPSF and JPEG. The format should suit the application you intend to use.
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This chapter describes:

• Mounting originals in the scanner

Mounting Originals
This section describes the various methods for mounting originals in the scanner.

Methods for mounting originals:

• Supplied masks

mix format mask

4x5 mask

6x7 mask

35-mm strip

slide holder

• User defined masks

• Mounting originals directly in the scanner

Note:  Before mounting, make sure the Base glass, Top glass and originals are clean.

Working with the scanner is more convenient and productive with masks. Therefore, 
using masks is highly recommended.

The advantages of using masks include:

• Preparing the originals in advance on a different worktable, while the scanner is 
busy with other scans.

• Positioning the originals is easier using the mask grid lines.

• The Base glass is kept clean (no tape marks).

• Defining multi-preview custom made formats. The defined user formats will 
appear in the Format list of the application. After preview, each image is 
displayed as a separate preview.

• Prevents light penetration, therefore increasing the scan quality.

Supplied Masks

35-mm strip mask

This mask allows you to mount up to twelve 35-mm strips without a need to cut 
them into separate images.

Mix format mask

With this mask, you can mount up to 26 transparencies of different sizes, such as 35 
mm, 6x7, or 4x5.
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4x5 mask

With this mask, you can mount up to 6 transparencies slides.

6x7 mask

With this mask, you can mount up to 20 transparencies slides.

Slide Holder

The slide holder is designed for scanning up to twenty 35-mm slides (framed 35-
mm transparencies). The holder has five (5) rows, each can hold four (4) slides. If 
necessary, a second holder can be used for scanning up to 40 slides.

To use the slide holder, perform the following:

1. To insert slides, hold the slide holder with the printed side facing you. Insert the 
first slide, emulsion side down and in the correct orientation, into the bottom 
row. Push it all the way to the end of the row.

2. Insert the other three slides in the same row.

3. When the first row is full, continue to the next row, and so on. Make sure each 
slide is in its correct orientation.

Note:  For efficient scanner work, it is recommended that the bottom row is filled 
first, and that each row is filled starting at the end of the row.

User Defined Mask
Your scanner is supplied with several identical User defined masks, suitable for 
transparency and reflective originals.

This section describes the following:

• Preparing the mask

• Defining user defined formats

• Using user defined formats

Preparing the mask

The User defined mask is an A3 (11 in. x 17 in.) opaque sheet; one side of the mask is 
for transparency, the other for reflective (as labeled on the mask). A set of barcode 
windows appears at one edge; the first and last barcode windows are always open. 
The other barcodes are not implemented in this version.

For transparency:

• Mark outlines of the originals on the transparency side of the mask, according to 
the format you want to define. The procedure for preparing the outlines should 
be similar to that for direct mounting in multi preview (see Direct Mount on 
page 11.). The first original outline should be near the 1,0 point at the lower right 
corner of the mask.

• Use a sharp knife to cut out a window for each original. Make sure not to cut the 
mask barcodes.
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The following figure shows the user-defined mask with cut windows for five (5) 
transparencies.

• Mount the mask (without originals) in the scanner with the transparency side 
facing up; insert the mask’s registration holes into the registration pins of the 
glass.

Note:  The 0,0 corner of the mask is approximately above the 0,0 corner of the Base 
glass.

For reflective:

• Tape the reflectives to the reflective side of the mask, according to the format 
you want to define. Make sure the image side is up and in the correct 
orientation.

The first original should be near the 0,0 point at the lower left corner of the 
mask. Taping the originals is similar to direct mounting in multi preview (see 
Direct Mount on page 11), but here you proceed from left to right. Make sure not 
to cover the barcode windows.

• To mount in the scanner, turn the mask over so that the transparency label of the 
mask faces up; insert the mask registration holes into the registration pins of the 
glass.

Note:  The 0,0 corner of the mask is approximately above the 0,0 corner of the Base 
glass.

The following figure illustrates the prepared mask mounted for reflective scan.

Note:  Since the reflective is taped to the other side of the mask, it is not shown in the 
figure.
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Defining user defined format

The user-defined formats must be defined in the application before you can use 
them. With the mask you prepared previously mounted in the scanner, follow the 
procedure described below for transparency and reflective.

1. In the Setup dialog box, choose the All Board format.

2. Perform Preview.

The Preview display window shows the entire mask. In transparency, the 
prepared windows are shown. In reflective, the taped originals are shown.

3. Crop each window/original in the Preview display window.

Note:  The system automatically adds 1.5 mm around your crops

4. From the File menu, choose Save User Defined. The Save User Defined menu 
appears.

5. From the Save User Defined menu, choose an option, depending on the format 
you want to define.

6. In the window that appears, enter the name of the new user defined format.

If you define a new format under an existing format name, the new format 
replaces the previous one. To delete a user format, delete the format file from 
the Tables folder.

Using user defined formats

When using the mask for transparencies, make sure the originals are taped to their 
windows, emulsion side down.

After application restart, the user-defined formats appear in the Format options in 
the Setup dialog box. Select the desired format when scanning according to this 
format. 

Direct Mount
Originals are mounted in the scanner by placing them directly on the Base glass. You 
can mount one original for single preview or several originals for multi-preview.

For single preview:

• Tape the original to the Base glass, placing the top right corner 
of the original near the 0,0 corner of the glass (lower right corner). Place 
transparencies with emulsion side down, and reflectives with image side down.

• It is recommended that if your original is a non-standard format, you should note 
the size of the original by checking the vertical and horizontal scales of the glass. 
This is important when using the Layout display window.

Tip:  When scanning a thick reflective such as a book, it is possible to scan with the Top 
door open

Note:  For high enlargements, we recommend you to use oil when mounting originals. 
For more information, refer to Oil Mounting on page 141.
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For multi-preview:

In multi-preview, all originals are taped to the Base glass and scanned in a single run. 
The originals must be of the same type (transparency or reflective), but may be of 
different sizes and media (positive and negative).

• Tape the first original near the 0,0 corner of the glass, same as for single preview 
(see above).

• Tape the other originals proceeding toward the lower left corner of the Base 
glass, making sure the originals do not overlap. If necessary, continue to the next 
row. It is recommended to place the originals in an orderly way, and not spread 
them randomly all over the board.

• If you intend to use the Layout display window, you should note the total size of 
the area occupied by the originals by checking the vertical and horizontal scales 
of the glass.

For further details, refer to Performing Basic Scan on page 38.
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Overview
In this chapter you will learn how to use the application tools and palettes. The 
keyboard controls and shortcuts appear at the end of the chapter.

The application tools controlling the foreground/background operations:

• Preview Browser

• Scanner Queue window

• Layout display

• Windows palette

• Scan palette

Refer to Layout Display on page 45 for a detailed description of the Layout display.

The application tools for defining and editing an image:

• Setup dialog box

• Image display window with its tools and display options

• Image palette

The Setup dialog box is described in Setup Mode on page 38.

As with other Macintosh applications, the window must be active if you want to use 
it. Click the window to activate it. (The Setup dialog box and the palettes are always 
active).
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The following figure is a schematic of your desktop, showing the various 
windows and tools.

Windows Palette

Menu bar

Scan palette

Setup dialog
box

Image palette

 

Scanner Queue
window

Floating 

Preview
Browser

Total Ink
Densitometer
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Preview Browser
The Preview Browser controls the operational stage of the previews.
It also gives the status of each original in the scanner.

Each window in the Preview Browser represents an image. An empty gray window 
indicates that the image has not been previewed. After Preview, Crop Prescan or 
Max Detail an image thumbnail appears in the window. 

Use the Preview Browser to control the following operations:

• To display an image in the Image display window, double-click its image 
thumbnail.

• Selecting images into the Queue window for preview or final scan For preview, 
click the empty gray window. For scan, click the image thumbnail (this is 
possible only if the Image display window is closed).

Note:  To select more than one image draw a box enclosing the images, or click each 
image while pressing Shift. To deselect an image, click while pressing Shift.

The Preview Browser provides the following status information:

• Format and number of originals in the scanner, and the file names of scanned 
images.

• Specific icons indicate if preview, crop prescan, max detail or final scan were 
performed. A blue icon and grey background means that the image is 
interactively modified.

• An arrow appears below the thumbnails of images currently in the queue 
waiting to be scanned.

• The thumbnail of an image currently displayed in the Image display window 
appears dimmed.

The three display options of the Preview Browser 

Click the relevant icon to choose the display option:

Show All; expanded Preview Browser, showing all thumbnails (all previews, crop 
prescans and max details).
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Show Previews; shows only Previews (one thumbnail per preview).

Show Preview family; shows one Preview and its crop prescans and max details .
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Numbered Mask Display
Numbers appear on the mask display, indicating the order in which the images are 
scanned.

The recommended scanning order is to start from the upper end of each column down 
to the lower end, beginning with the column that is farthest to the right, as shown in the 
figure.
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Scan Palette
The Scan palette is used to perform preview, crop prescan and final scan, and to 
restart the application. The Scan palette is always displayed on the desktop when 
the application is open. The echo line, at the bottom of the palette, describes the 
icon at the pointer’s position. The active icons depend on the current mode of 
operation.

To select a function, click its icon. When an image is displayed in the Image display 
window, the selected function is performed on the image; when an image is not 
displayed, the function is performed on selected preview thumbnails in the Preview 
Browser.

The Scan palette includes:

Preview icon; active in Setup mode, when there is an image to be previewed.

Prescan icon; active in Preview mode, when a crop (not yet prescanned) is defined on 
the displayed Preview. To prescan all crops on the Preview, press the <Option> key 
and click the multi-prescan icon that appears.

Scan icon; active in Preview mode, when there is a preview or crop to be scanned. To 
scan all crops on the Preview, press the <Option> key and click the multi-scan icon 
that appears.

Fast Pre-Scan; shows the rotated crop in the same size as it was displayed in the 
original preview. Fast Pre-Scan is recommended when a crop is large enough for 
further editing.

Photoshop icon; allows you to open the scanned image in Photoshop with a single 
click.

Restart icon, to return the application to Setup mode.
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Note:  The Scan palette functions can also be selected from the Scan menu in 
Menu bar.



Scanner Queue Window 21

Scanner Queue Window
The Scanner Queue window manages the background operation of the scanner, that 
is, manages your scanning requests.

Images selected from the Preview Browser for preview or scan, enter the Scanner 
Queue window. Crop prescan and max detail requests also enter the queue. The item 
is scanned when it reaches the top of the queue, and a Progress indicator appears 
below this item. You can edit the queue, as explained below. 

Note:  When you enter the application or after Restart, the queue is empty.

Scanner Queue window with: max detail currently being scanned, crop prescan 
group, one preview, and one final scan. 

The queue order is according to a fixed priority. The priority order is (from high to 
low): max detail, preview, crop prescan, and final scan. When a max detail with 
defocus is requested, the queue is suspended. Within each priority group, items are 
arranged according to the order in which they entered the queue.

To minimize the Scanner Queue window, press the zoom box (upper right). The 
window then shows only the item currently being scanned and a Progress indicator. In 
the full Scanner Queue window, the scroll bar on the right side is used to scroll the 
window.

Each queue item has the following: 

• Serial number, indicating position in the queue. The item currently being 
scanned is number 1 with an arrow, and colored green. Serial numbers are 
constantly updated, as items enter or leave the queue and/or you edit the 
queue.

• Image file name.

• An icon indicating if the item is waiting in the queue for preview, crop prescan, 
max detail or final scan.
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Editing the queue:

• To rearrange the queue, select and drag the item to its new position. All other 
items are automatically rearranged.
In Prescan All or Scan All, items belonging to the same Preview are grouped 
together (enclosed by a box). You cannot divide the group, or move a group 
item.

Note:  If grouped items are processed when a max detail enters the queue, the group 
is divided. The max detail enters the top of the queue and the unprocessed group 
items are scanned after the max detail

• To delete an item or a group waiting in the queue, select it and press the 
<Delete> key. You cannot delete items within the group. 

• To delete an item currently being scanned (the top most item), select it and 
press <Delete>. The system prompts for one of two options: delete the item 
from the queue, or re-enter it into the queue. If you choose to re-enter, the item 
enters the queue according to its priority. For example, a preview is re-entered 
as the last item in the preview group.
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Windows Palette

The Windows palette opens and activates the following application windows:

• Setup dialog box

• Preview Browser

• Scanner Queue window

• Layout display window

In the Windows palette, click the relevant icon to open the requested window (if it is 
closed) and activate it. This is also useful if the window is hidden by other windows.

If the Windows palette is not open or not shown, select Windows palette from the 
Windows menu in Menu bar.

To close the Windows palette, click its close box.
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Image Display Window
The Image display window is used for interactive work with the image. The window 
includes the display area and various tools and display options that are arranged 
along the left and bottom sides of the display area. The following figure illustrates 
the Image display window.

Tools

Display area

File Information

Floating Densitometer Display separations
Split screen

UCR 
indicator

Split screen

Total Ink
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Display Area
After Preview, the first Preview image is automatically displayed in the display area. 
To display a prescanned image, double click its image thumbnail in the Preview 
Browser.

For the displayed image you can:

• select an editing function; in interactive functions, you can view applied changes 
and compare the before/after display. See Split Screen, below. Color Correction 
Mask allows you to see the color corrections on the preview immediately, before 
applying the changes.

• select a cropping or sampling tool.

• choose a display option.

In addition, the letters U, G or A appear in the upper right side of the display area if 
UCR, GCR or UCA is active during preview. 

For further details, refer to Separation Setup on page 112

Split Screen
Split screen is a convenient tool during interactive editing, for comparing the image 
before and after update. When you open an interactive function, two handles in the 
shape of black rectangles appear at the right side of the Image display window; the 
upper handle for horizontal split, the bottom handle for vertical split.

• Drag the horizontal (or vertical) handle to the location at which you want to split 
the image. In horizontal split, the area above the marker is before Apply, the area 
below the marker is after Apply. In vertical split, the area to the left is before, the 
area to the right is after.

• For comparison purposes, you might want to display the same image area in the 
two sections of the split window. Using the scroll bars, scroll the split image so 
that the same image area is shown in each section.

• Move the handle to reposition the marker; double click the handle to cancel the 
split screen and restore the full display.

Note:  The densitometer reading shows both the before and after values. Refer to 
Floating Densitometer on page 31.

Tools and Display Options
This section describes the cropping and sampling tools, and the display and 
information options that appear along the left and bottom sides of the display area. 
These are used when viewing the image and when performing interactive editing.
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When the Preview is first displayed in the Image display window, a crop frame 
encloses the image. This is the Full image crop, set according to the selected format. 
The area enclosed by the crop frame is the final scan area. Using the cropping tools, 
you can change the crop size and position.

Note:  The following elements are described in the order in which they are arranged, 
starting from the upper left corner.

System Default Pointer

 

This is the system default pointer, used to change the position and size of the crop 
frame. 

1. Select the pointer and move it inside the crop frame.

2. When you press the mouse button, the pointer changes to a Hand. Drag the 
Hand to move the frame, and release the mouse to set the new position. 

To change the crop size:

1. Move the pointer to a frame corner or to the center marker of one of its sides. 
The pointer changes to a set of arrows, pointing in the directions that you may 
move the frame.

2. Press the mouse button and drag the frame side or corner; release the mouse to 
set the frame size.
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Cropping

To define and draw a new crop. 

Select the tool and click a point in the image to mark the top left corner of the crop.

3. Press and drag the mouse button to the desired lower right corner. Release the 
mouse to set the crop.

4. To move or change the crop size, use the system default pointer (see 
previously).

Note:  To reset the crop to the Full image crop.

Scaling

To set the enlargement of the final scan, using the Two-point method. In the Two-
point method, the system calculates the scale based on the input and output sizes. 
The input size is the actual distance between two points on the original; the output 
size is the distance between the two points in the final scan; the scale is the ratio 
between the output and input sizes. 

1. Select the Scaling tool and click the first point in the image (do not release the 
mouse).

2. Drag the mouse to the second point and release. The Scaling dialog box opens. 
The Input Size is the original distance between the two marked points.

3. In the Output Size field, enter the output distance between the points (that is, 
the desired distance in the final scan).

4. Click OK. The system calculates the new value and updates the Scale value in 
the Setup dialog box.
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Reset Crop

Click this tool to set the crop to the Full image crop. 

Max Detail

To perform a max detail prescan. This option is useful for examining the results of 
sharpness, and/or edit the sharpness parameters. 

For details, refer to Performing Max Detail on page 123

Sample Points
Sampling points from the image is possible when performing interactive image 
editing. Two tools are relevant to this function: Sampler and Show/Hide Sample 
Points. See the following description. 

Sampler

The Sampler is active in interactive editing functions, such as Gradation and End 
Points. It is used to sample points from the image and see the effect of your changes.

1. When an edit dialog box is open, click the Sampler tool. The Sample Points dialog 
box appears. 

2. Using the Sampler, click a point on the image.

Note:  To sample points, the Sampler must be active. If inactive, click the Sampler at 
the upper left corner.

The CMYK or RGB values and the color patch of the selected point are shown. 
This is a floating sample point, as it changes when you click the Sampler on other 
points. 

3. If the sample points are not shown, click the icon to show the points on the 
image. To open the Sample Points dialog box or to add/delete points, you must 
select the Sampler tool.
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4. If the sample points are shown, click the icon to temporarily hide them. The 
points are not deleted; if you click the icon again, they reappear.

Note:  The sample points are deleted when you exit the application.

Before image editing changes, the After colors of the sample points are identical to 
the Before ones. However, when using an editing function, such as Gradation, your 
changes are shown in the after colors.

1. To close the Sample Points dialog box, click its Close box. (In addition, the dialog 
box automatically closes when you exit the editing function.) The fixed sample 
points remain marked on the image when the Sample Points dialog box is closed.

2. To open the Sample Points dialog box, click the Sampler tool. The dialog box 
opens with the existing fixed sample points.

HSL

Click the HSL icon in the dialog box to display the HSL values of the sampled points. 
This is useful when using the Color Correction function.

Show/Hide Sample Points

Active after sample points are selected with the Sampler. This tool is used to 
temporarily show or hide the sample points on the image.

Line-art/B/W Display

Active only in Line-art mode, where two display options are available. Click the 
requested icon:

Line-art (for black and white pixels only)
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B&W (for black, grays and white).

Note:  In B&W mode, there are no display options.

Show/Hide End Points Markers

Active when the Preview window is shown. This tool is used to temporarily show or 
hide End Points Markers.

For details see Show End Points.

Show/Hide Sharp Effects

Active after Max Detail, and only if the max detail is displayed in the Image display 
window.

The results of sharpness editing can be viewed only in max detail and only if the 
sharp effects are shown. The max detail image is automatically displayed with the 
sharp effects on. Click the icon to show or hide these effects, as desired.

For details, refer to Max Detail in Interactive Sharpness Editing on page 123.

File Information

The file size appears at the bottom left corner of the Image display window. The file 
size in KB (thousands of bytes) is the size of the final scan file, based on current scan 
file settings.

Click File Information at the bottom of the Image display window to open the File 
Information window.
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Floating Densitometer

The floating densitometer, at the bottom of the Image display window, shows the 
values at the pointer’s current location. The densitometer reading depends on the 
selected mode and on the defined densitometer setup.

For more information, refer to Densitometer Setup on page 152.

When using split screen in interactive editing, the densitometer reading shows both 
the before and after values for each separation.

Display Separations

Only for CMYK and RGB Color modes. The Display separation fields appear at the 
bottom of the Image display window, to the right of the floating densitometer.

The available display options are determined by the selected Mode in the Setup 
dialog box: 

For CMYK color: CMYK, Cyan, Magenta, Yellow, Black

For RGB color: RGB, Red, Green, Blue

For the displayed image, click the icon of the separation you want to display. Choose 
all separations (CMYK or RGB) or a single separation.

When you change the Mode, the Display separation fields are updated accordingly.

Note:  In B&W and Line-art modes, only the black separation is displayed.

Image Palette
The Image palette appears after Preview and if an image is displayed. Its icons 
represent the main image editing functions. The echo line at the bottom of the 
palette, describes the icon at the pointer’s position. To select a function, click its 
icon. The function dialog box appears and the palette is disabled temporarily until 
you exit the dialog box.

Tip:  Split screen is available for all interactive functions accessed in this palette (see 
Split Screen on page 25).

Image palette features:

• Active icons depend on the Mode and Media of the displayed image. For 
example, Filmtype is active only for color negatives.

• The icons are arranged, from left to right in the order in which it is recommended 
you should use the functions. End Points is the first icon since it is the first 
function you should use if image editing is necessary.
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The Image palette icons (from left to right):

End Points, in the Color and B&W modes to adjust the End Points.

Gradation, in the Color and B&W modes to create/modify Gradation tables.

Sharpness to edit the Sharpness table.

Color Correction, only in the Color modes to edit the Color table.

LS Curves, to perform color corrections in an image by modifying the luminance and 
the saturation values of a selected color.

Line-art, only in the Line-art mode to set the Line-art controls.
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Keyboard Controls
The following keyboard controls are available in the application.

Note:  All keyboard controls are listed under Help in Scanner Help.

Control

To see only the crop area. Press the <Control> key to display the area outside the 
crop in white.

Option/Alt

Press the <Option/Alt> key to change the Prescan and Scan icons in Scan palette to 
Prescan All and Scan All.

Shift in Image display window

To maintain the crop proportions when changing the crop size. When you press 
<Shift>, the frame increases/decreases in size, but the height/width ratio does not 
change.

Shift in Preview Browser

To select multiple items in the Preview Browser window. Press <Shift> and click on 
the items.

Shift in Queue window

To select multiple items in the Queue window. Press <Shift> and click on the items.

Shift in Sample Points dialog box

To add fixed sample points. Press <Shift> and click on the sample points.

Shift in End Points dialog box

In Set White (Dark) Pt, if you press <Shift> while setting the White (Dark) point, 
the Sampler remains active.

Delete in Image display window

To delete the active crop.

Note:  If the active crop is a Full picture crop, it cannot be deleted.

Delete in Setup dialog box

To delete the value in the active text field.

Delete in Queue window

To delete selected items from the queue.

Tab in Image display window

To cycle among the crops until the desired crop is active.

Tab in Setup dialog box

To move to the next text field.
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Keyboard Shortcuts
The following keyboard shortcuts are available in the application.

Note:  All keyboard shortcuts are listed under Help in Scanner Help.

< >BB&W or Line-art display in Line-art mode

< >DDuplicate Crop

< >EOpen the End Points function

< >FShow/Hide Sharp Effects

< >GOpen the Gradation function

< >HPerform Crop Analyze

< >JOpen the Color Correction function

< >KOpen the Operation Modes Preferences

< >MOpen the Sharp function 

< >NOpen the Negative Balance function for Negatives

< >PPerform Preview 

< >QQuit application 

< >RRestart application 

< >SSave Params for Scan 

< >TSet the Line-art threshold in Line-art mode 

< >UUnlock Crop 

< >WClose Window

< >+ /-Increase/decrease the Max Detail area

< >0Show All Separations 

< >1Show Cyan Separation 

< >2Show Magenta Separation 

< >3Show Yellow Separation 

< >4Show Black Separation
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Overview
In this chapter, you will learn how to:

• perform a basic scan of a transparency/reflective in the 
RGB/CMYK, B/W, Line-art or DT mode

• use cropping and scaling tools, Smartset tables and different layout formats

• define setup parameters, and perform preview, prescan and final scan

Entering Application
1. Make sure that your scanner is turned on.

2. Double click the scanner icon located in the oXYgen folder.

The oXYgen opening display appears on screen for a few seconds, followed 
by the Setup dialog box and Menu bar. 
You have now entered the scanning application.

Note:  If the application cannot locate the Tables folder, a folder selection dialog box 
appears. In the dialog box, select the Tables folder and click Set.

3. To close the application, from the File menu in the Menu bar, select Quit

4. To close the application and return to the default parameters, from the File 
menu in the Menu bar, select Quit&Reset Prefs
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When you re-launch the application you are prompted to relocate the Table folder.

Send to Support Feature
The Send to Support feature centralizes important log information as you work.

To activate Send to Support, use one of the following methods:

1. From the menu, select Help>Send to Support.

2. Open the oXYgen Scan folder, and then click the Send to Support icon.

Log files containing important information are automatically generated and

centralized in a Send to Support folder on the desktop.

To report log information:

Send the contents of the Send to Support folder on the desktop directly to the 
Kodak Response Center or via your Kodak support representative.
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Performing Basic Scan
This section describes how to perform a basic scan:

• in the RGB/CMYK mode using ICC profiles to achieve optimal color conversion 
and soft-proof the results on the screen.

• in the B/W or Line-art mode.

Note:  ICC profiles (input, output, or display) store a map from the device-dependent 
color space (usually some form of RGB or CMYK) into a device-independent color 
space (the PCS). Such profiles are created by designated software packages. The 
Scanners are fully compatible with profiles built by any profiling applications on the 
market. 

For more information about the ICC workflows, refer to ICC Workflows on page 74.

Setup Mode
The following figure illustrates the Setup dialog box in Setup mode, when you first 
enter the application.

Tip:  Restart in the Scan palette can be used to re-enter the Setup mode

The Setup dialog box defines the various parameters to be used during the Preview 
process.
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The Setup dialog box is divided into three sections:

• Original and format parameters

• Size and scale parameters

• Image adjustment parameters

Setup Parameters
Type

From the Type list, choose Transparent or Reflective, according to the type of 
original.

For transparent, choose one of the options:

• Regular - for masked or direct mount originals

• Framed - for framed originals

• Mixed - for mixed mask

For reflective, choose one of the options:

• Regular - for reflectives with a smooth surface

• Pasteup - for reflectives that have something pasted on them, such as a label
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Mode

From the Mode list, choose Color CMYK, Color RGB, B&W, or Line-art 
depending on desired output.

• Choose Color CMYK for printing systems, and Color RGB for RGB printers and 
multi-media systems, such as presentations and Web.

• Choose B&W to create a B&W file from a color image taking into consideration 
all the image colors, or to create a B&W file from a B&W image. One separation 
is created in the final scan.

• Choose Line-art for a Line-art scan, where the created image is in black and 
white only.

B&W, and Line-art scans are described in B&W Mode on page 137 and Line-art 
Mode on page 138

Note:  CopyDOT and Descreen are available only if you have purchased the CopyDOT 
application.

• Choose DT File for scanning 16-bit images.

For more information, refer to Scanning DT Files in oXygen Scan on page 68

Format

The application is supplied with standard layout formats according to the selected 
mode. The layout format options for Color RGB/CMYK and B&W modes are shown 
on page 137. Line-art mode is discussed in Line-art Mode on page 138. In addition to 
the standard layout formats, user defined formats that you have created are also 
listed. The various formats are detailed further on.

Creating user layout formats with the user defined mask is described in User Defined 
Mask on page 9

From the Format list, choose your layout format; if your format is not listed, use 
the Layout display to modify the scan area (see Layout Display on page 45) or 
choose a layout format closest to your format and modify it after Preview.

Note:  All standard layout formats are defined starting at the 0,0 corner of the Base 
glass.
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The Preview Browser is set according to your selection, and the layout format name 
appears in the Preview Browser. In single preview layout formats (such as 35mm), a 
single preview window is shown. In multi-preview layout formats, the number of 
windows depends on the number of previews.

Note:  When you first enter the application, the Format and Preview Browser are set 
according to the previous run.

Strip 80 mm (transparency)

This option is used to scan many originals of a width up to 80 mm in a shorter 
scanning period. The originals are placed along a 80-mm wide strip starting at the 
0,0 lower right corner, and extending the entire length of the Base glass. The scanner 
prescans the entire strip and displays the originals as a single preview.

35 mm, 6x6, 6x7, 4x5, 8x10H/V (transparency)

Single preview formats for originals that correspond to the format size.

All Board (transparency/reflective)

In All Board, the entire board is scanned, and the originals are displayed as a single 
preview.

35-mm slide holder / 2 x 35-mm slide holder

Multi-preview formats for 35-mm slides that are mounted in the scanner using a 
specially designed slide holder. 

Note:  The 2x35-mm slide holder is only available in the Eversmart family

See Mounting Originals on page 8 for details on using the holder.
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35 mm strip/mix format supplied masks

For details on these formats, refer to Supplied Masks on page 8.

When you need to scan strips of 35 mm, or originals of various sizes, choose the 
format that represents the mask you use.

User defined formats

User defined formats are custom-made transparency and reflective formats. User 
defined formats for masked originals are described in User Defined Mask on page 9. 
User defined formats for unmasked originals are described further on in the Layout 
display.

Note:  Custom format appears if you modify the scan area in the Layout display in the 
current run without using save (see Layout Display on page 45).

Media

From the Media list, choose Positive or Negative, according to your original. In multi-
preview, if you have positive and negative originals, choose the option that is relevant 
to most of the originals. After Preview, choose the correct option for each preview.

Smooth

In some cases, a certain amount of smoothening is required:

• The dot pattern might be visible in printed material. Descreening blurs the dot 
pattern without degrading the image.

• Lines might appear with jagged edges. Anti-alias minimizes the pixel contrast at 
the edges, causing them to be smoother and blend in the background. It can also 
remove unwanted moiré.

Smooth options include:

• None; no smoothening effect.

• Descreen1 to Descreen10; descreening levels for printed material.

For more information, refer to Printed Material on page 135

• Anti-alias normal, Anti-alias strong; two levels of anti-alias for lines.

Note:  The effect of smooth can be seen in the final scan or in max detail.
For further details, refer to Interactive Sharpness Editing on page 123.

Unit of Measurement

Choose inches, mm, points or picas as the unit of measurement for the Crop Height/
Width and Scan Height/Width fields.
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Scale

Sets the enlargement by which the scanner scans the original. A scale of 100% 
indicates that the scanned file is the same size as the original.

Mirror

Check the Mirror box to create a mirrored image of the scanned original.

Note:  When mounting a duplicate, place it emulsion side down and use Mirror to obtain 
a correct image.

The Mirror option is available only before previewing the images.

Resolution

Resolution specifies the number of dots (pixels) per millimeter or inch of the final 
image, and is related to the halftone screen. 

When setting the resolution, you should consider the screen. For higher or finer 
screens, the resolution value should be higher to capture the additional information. 
The minimum output resolution is 2 DPM (51 DPI). Resolution and Scale are related, 
as explained in Scale on page 43.

A rule of thumb formula, commonly used to determine the average input resolution, 
is as follows:

Halftone screen per inch (or per mm) x 2.0 = resolution in dots 
per inch (DPI) or per mm (DPM).

For example, an image to be output as an 150 LPI halftone is calculated: 150 x 
2.0 = 300 DPI. Therefore, the resolution is set at 
300 DPI.

Choose DPM (dots per millimeter) or DPI (dots per inch) as the resolution unit 
of measurement, and enter the requested resolution value.

Image Adjustment Parameters

ICC Profiles

For scanning with ICC profiles, select as an input profile your scanner profile that 
reflects the type of your original (transparent, or reflective). As an output profile, 
select your output device profile. Alternatively, you can select a device link profile.

A Device Link profile is a combined input and output profile - a link between the 
scanner and a specific output device. It allows you to fine tune the transformation 
and improves your color quality control.
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End Points, Gradation and Sharpness

Make sure to set the End Point, Gradation and Sharpness parameters according to 
your scanning needs.

SmartSet
The Smart Set feature automatically adjusts the scanning parameters of an image 
according to preset input categories, allowing you to achieve print-ready quality 
with a single keystroke.

You can choose from among several, pre-defined SmartSet tables that are related to 
certain subjects, such as people, jewelry, or outdoor scenes, and can be applied to 
scans. Each SmartSet table is constructed to accommodate a broad range of 
variables within a general subject matter. Every SmartSet table is comprised of 
several different tables that normally would have to be loaded manually. 

SmartSet Tables are used in the following functions:

• Device Link

• End Points

• Gradation

• Sharpness
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Make your selection in SmartSet according to the main subject of your scan. The 
application loads an appropriate group of tables.

Note:  In the SmartSet list, you have two kinds of SmartSet tables: the tables above the 
line contain a device link profile; the tables below the line contain the old color tables 
(LUTs).

You can define a new SmartSet by loading different tables. The SmartSet name 
changes to Custom, and then you can save the new SmartSet with a name you 
choose.

You can also customize additional tables that you define according to your own 
requirements and can save for later use. To save a SmartSet custom table, you must 
save any table that is labeled Custom with a new name. In other words, you cannot 
save a SmartSet with a table labeled Custom.

The SmartSet tables can incorporate any of the application features that are 
described in Chapters 6-8.

Layout Display
The Layout display reflects the selected Format option (see Format on page 40). You 
can use the Layout display to modify the scan area before Preview. In some cases, this 
can reduce the scan time, and the displayed preview image is larger. The Layout 
display is useful in the following cases:

• When the mounted originals are not according to pre-defined formats, which 
include the standard application formats and created user defined formats.

• In multi-preview formats, when you want to scan only some of the originals.

To use the Layout display

1. After selecting a Format option, the Layout display shows the Base glass and a 
window(s) representing the selected layout format.

Note:  The Layout display automatically appears if you check Open Layout Display 
after Restart in Operation Modes, under the Setup menu.
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2. In single preview layout formats, you can change the scan area size in one of the 
following ways: 

• Click and drag one of the window corners (marked by an arrow), then release to 
define a new window. The window marks the effective scan area; 
or

• Change the scan area location by clicking inside the window and moving it to the 
desired location.

Note:  Since the Layout display does not show the mounted originals, it is helpful to 
note the size and location when mounting the originals in the scanner 
(for more information, refer to Mounting Originals on page 8).

3. In multi-preview layout formats, e.g., mix format mask, select the windows you 
want to scan by drawing a rectangle enclosing the requested windows, or press 
Shift and click on each window.

Note:  Using the Layout display is more accurate than selecting from the Preview 
Browser, because the Layout display shows an accurate mapping of the slide holder, 
thus making it easier to select the exact windows for scan

4. Click the Preview icon in the Scan palette to send the defined window(s) to the 
Scanner Queue window for preview.

The following figure illustrates the Layout display representing the mix format mask.
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To update or save the format: 

In single preview, format in the Setup dialog box automatically becomes custom 
when you modify the scan area in the Layout display, and the Preview Browser is 
updated accordingly. 

In multi-preview layout formats, click Set in the Layout display to update the 
Format and Preview Browser. The Format and Preview Browser become custom. 

In single and multi-preview layout formats, you can save the modified format. To 
do so, click Save in the Layout display and enter the new layout format name in 
the window that appears. 
The Format and Preview Browser are updated with the new name. The new 
format is not deleted when you exit the application, and is available for future 
use.
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Performing Preview
After setting the necessary parameters in the Setup dialog box, you can preview the 
originals. Preview creates a low-resolution scan of the image.

Click the Preview icon in the Scan palette, or choose Preview from the Scan menu 
in Menu bar.

All originals in the scanner are sent to the queue for preview. If you modified the 
effective scan area using the Layout display, only originals within this area will be 
previewed. In the Preview Browser, 
a Preview icon with an arrow indicates that the item is in the queue. 
A Progress Indicator is displayed during the preview process.

When the preview is completed, the first original appears in the Image display 
window (shown below). You are now in Preview mode, described in the next section.
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Preview Mode
This section describes how to prepare the Preview for final scan, including:

• Setup dialog box options

• Preview cropping and multi-crop

• Saving user defined formats

• Performing Crop prescan

• Performing final scan

In the Preview mode, the following items appear on the desktop:

• A low resolution image of the first original is shown in the Image display window.

• The Setup dialog box is set to the displayed Preview.

• An image thumbnail of each Preview appears in the Preview Browser, with the 
Preview name and the Preview icon. 
The thumbnail of the displayed Preview appears dimmed.

• The Scan and Image palettes with the relevant active tools.

Setup Dialog Box in Preview Mode
In the Setup dialog box - Preview mode, you can perform the following: 

In Color or B&W modes, you can switch between Color 
RGB/CMYK and B&W modes (you cannot choose Line-art).

In multi-preview with positive and negative originals, the selected Media might 
not be correct for the displayed Preview. In this case, choose the correct option, 
Positive or Negative.

Note:  The image thumbnail in the Preview Browser does not change after you 
change the Mode or Media options.

You can change the Scale value, by entering a new value or image size, or using 
the Scaling tool (on left side of display area). 

You can change the input/output profile, and the End Points, Gradation, 
Sharpness and device link values.

Whenever the image can be updated, Apply becomes active. For example, after 
defining a crop, Apply performs a crop analysis and selects new end points, or after 
changing color profiles, Apply updates the image with the new table. 

Crop and Multi-Crop
When the Preview is first displayed, the Full image crop is defined, enclosing the 
entire image. The system assigns a default name Scan_X_1 to this crop, where X is 
the Preview number. You can modify this crop and create additional crops.

Note:  The first crop cancels the automatic crop.
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Auto Naming for Final Scans

Auto Naming for Final Scans allows you to automatically set the scan name by 
using the Prefix/Suffix Setting option. You can select the option to add a prefix/suffix 
according to the file formats. The suffix will be added before sending the crops to the 
final scan. 

To use Prefix/Suffix Settings function:

1. From the Setup menu, choose AutoNaming Setup to open 
the Prefix/Suffix Settings dialog box. 

The system adds Scan-prefix to the final scan name by default.

2. To edit or delete the prefix, or to add a suffix, check the Prefix 
and/or Suffix option and enter the prefix/suffix you want in the 
text box.

3. To use the default name (e.g., Scan_ 1_1), select Default.

4. To add a file format suffix to the name, check the File Format Suffix option. You 
can apply this option only when scanning in 
the Color or BW mode.

Cropping the Preview

You can modify the Full image crop, decrease its size.

To define a new crop, use the cropping tool.

For more information, refer to Tools and Display Options on page 25.

Note:  The Full image crop no longer exists after it is modified or a new crop is created.

If you change the Crop Height/Width proportionally using the Shift key, the Scale 
value changes, but the Scan Height/Width remain constant.

Once you choose Reset Crop button the image returns to the original file size

If you change Scale, the Crop Height/Width or Scan Height/Width changes 
accordingly, depending on which is modified last.
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A Warning icon appears in the Setup dialog box if the scan cannot be performed 
according to the defined settings, because these settings exceed the scanner 
limitations. For example:

• Crop is too small (less than 65 pixels in the output width).

• Resolution is less than 2 DPM (51 DPI).

• When the entire image is scanned in maximum scale and with a scan margin.

You may define the final scan parameters by selecting Save Params for Scan 
from the File menu in the Menu bar. Define the scan parameters in the Scan 
dialog box. 

To define a second crop, repeat the procedure used for the first crop. You can 
also use the Duplicate Crop option in the Edit menu, or the keyboard shortcut 
< D>. The active crop is duplicated and positioned at a fixed offset from the 
previous crop. The new crop becomes the active crop, and may be edited (as 
explained for the first crop).

Repeat the procedure for as many crops as you wish to define on the Preview. 
The following figure shows an example of two crops defined on a single Preview.
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Multi-Crop Features

• Each crop has a complete set of parameters as if it were a single crop. 

• Crop analysis is performed for each crop, and the White/Dark points are 
selected according to the image data of the crop.

• A crop must be active for you to edit or change it. To activate a crop, use the 
<Tab> key to cycle among the crops until the desired crop is active, or click 
inside the crop area.

• Only one crop can be active at a given time. An active crop is indicated by the 
following features:

The crop parameters are shown in Setup dialog box.

In the Preview display window, the crop name, crop handles and Top left 
indicator is displayed.

Note:  If a crop is enclosed by a larger crop and you want to activate the smaller crop, 
press the <Tab> key until the smaller crop is active. If two crops overlap, click inside 
the area that does not overlap.

• If you edit the crop and Apply changes, the changes are applied to the entire 
Preview display. However in the final scan, these changes are effective only for 
the specific crop.

Crop Parameters

Some crop parameters must be identical for all the Preview crops, and some may be 
changed for specific crops. When defined, the new crop inherits the parameters of 
the active crop, excluding the Crop Height/Width and Scan Height/Width. In 
Duplicate Crop, the Crop Height/Width and Scan Height/ Width are also inherited.

Note:  A Custom table is not inherited. The new crop inherits the table on which the 
Custom table was based.

You may change the following crop parameters: Media, Mode, Scale and 
Resolution, Crop H/W and Scan H/W, and final scan format. 
You may also choose other Input/Output profiles, End Points, Gradation, and 
Sharpness tables (and Filmtype for negatives).

To delete crops:

1. Make sure the Preview display window is active.

2. Activate the crop you want to delete.

3. From the Edit menu, choose Delete Crop, or press the <Delete> key.

Note:  If the Setup dialog box is active instead of the Preview display window and you 
use the Delete key, the value in the active text field in the Setup dialog box is deleted.

If the crop to be deleted is currently in the queue, a message is displayed and the 
crop is not deleted. If a Crop Prescan or Max Detail has been performed, a message 
is displayed and the crop is deleted only after OK.

After the crop is deleted, the next crop becomes active. If there are no other crops, 
the Full image crop becomes active.
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Save User Defined Formats
After Preview, you can save the preview crops as user defined formats.

To save a preview crop as a user defined format, perform the following:

1. Define the necessary crops on the Preview.

2. From the File menu, choose Save User Defined. The Save User Defined menu 
appears.

3. From Save User Defined menu choose an option, depending on the format you 
want to define.

4. In the window that appears, enter the name of the new format. 
The format name will appear in the Format list after scan restart.

Crop Prescan
Crop Prescan is recommended if the crop size is smaller than one third (1/3) the 
size of the Preview. Using Crop Prescan, a more accurate image analysis is obtained 
for the crop. The low resolution crop image is displayed in the Crop Prescan display 
window, showing more details and/or colors of the crop.

To perform Crop Prescan, perform the following:

1. Activate the crop for which you want to use Crop Prescan.

2. Click the Prescan icon in the Scan palette. Press the Option key while clicking 
the icon, to send all crops on the Preview to the Queue window for prescan.

After Crop Prescan, an image thumbnail of each crop prescan appears in the 
Preview Browser with the file name and the Prescan icon.

3. To display the Crop Prescan image, double click its image thumbnail.

The Crop prescan image is displayed and the Setup dialog box is set accordingly. The 
following figure shows the Crop Prescan window.
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4. If required, you may edit the crop as explained in the previous section. But you 
cannot change its size after Crop Prescan.
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Performing Scan
The Scan function scans the image to the disk, resulting in a high-resolution image. 
The scan is performed according to the Setup dialog box settings and defined scan 
parameters. 

For details on opening scanned images in Photoshop, refer to Opening Scanned 
Images in Photoshop on page 76.

In the basic workflow described in this chapter, a scan is performed after cropping 
the Preview and setting the necessary parameters in the Setup dialog box.

Note:  You should postpone the final scan if further image editing is necessary.

To scan the preview, perform the following:

1. In the Scan palette, click the Scan icon, 

or
From the Scan menu in Menu bar choose Scan, point to Scan All, and then select 
Active crop.

2. In multi-crop, press Option while clicking the Scan icon to scan all crops on the 
Preview, 
or
Choose Scan All from the Scan All menu.

3. Use Save Params for Scan under File in Menu bar for defining the scan 
parameters when editing the crop and before selecting Scan. If you did not 
define parameters for all the crops you are sending for scan, the Scan dialog box 
is displayed.

4. If the scan parameters have not been defined, the Scan dialog box appears for 
all crops that do not have defined scan parameters 
(see Scan dialog box on page 56).

The selected items are sent to the Scanner Queue window for scan. 
In the Preview Browser, a Scan icon with an arrow appears below the image thumbnail 
of the Preview (the arrow disappears after the scan). In multi-crop, all crops enter 
the Scanner Queue window as a group, and the Preview display window closes.

While the scan is performed, you can display and edit other crops or previews (that 
are not in the Scanner Queue window).

If the Beep option in Operation Modes Preferences (under Setup in Menu bar) is 
selected, the scanner beeps three times when each scan 
is completed.

To scan the crop prescan:

To scan the crop prescan, the Crop Prescan image must be displayed in the Image 
display window. The scan process is the same as for Previews.

1. To select scan items from Preview Browser, perform the following:

2. Make sure the Image display window is closed.

3. In the Preview Browser, press Shift and select the Previews that you want to scan.
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4. Click the Scan icon in the Scan palette, or choose Scan from the Scan menu.

If scan parameters have been defined for all selected items, the items enter the 
Scanner Queue window for scan. If the preview has crop prescans, these also enter 
the queue. The scan process is the same as for single Preview.

If scan parameters have not been defined, the Scan dialog box appears for all 
undefined previews and crops.

Scan dialog box
The parameters in the Scan dialog box must be defined before the scan is performed.

Note:  When you enter the Scan dialog box, the listed file format is the format used in the 
previous scan of the current mode.

In the Scan dialog box, do the following:

1. Enter the scan file name in the ‘Save Scan as’ field. You can either use the default 
name, or enter a new name.

2. Choose the file format. Available formats depend on the selected Mode. The 
selected format should be according to the application you intend to use with 
the scanned file. 

When you scan using ICC profiles, and you want to embed the profile, select either 
TIFF or EPSF format. Then, click Embed ICC Profile-Size.

3. Set the destination folder of the scanned image.

4. Click OK to send the item to the Scanner Queue window for scan.
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File Formats

The following file formats are available:

• EPSF (Encapsulated PostScript File)
PICT preview is available. Output is four separations (CMYK) 
32 bits/pixel, three separations (RGB) 24-bit/pixel, a DCS 5 file format, or an 
ICS 5 file format.

• TIFF (Tagged Image File Format)
Output is one RGB file 24 bits/pixel, or one CMYK file 
32 bits/pixel, or CMY file 24 bits/pixel. PICT preview is not available. 

• JPEG (Joint Photographic Experts Group)

This format is commonly used to display continuous-tone images. When saving in 
JPEG format, you can specify the image quality and compression level. A higher level 
of compression results in lower image quality, and a lower level of compression 
results in better image quality.

Available formats according to the selected Mode option:

Format CMY
K

RGB 
8/
16bit

B&W Line-
art

DT File

EPSF yes yes yes yes no

TIFF yes yes yes yes yes

JPEG yes yes yes no no
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Defining a Crop Area for Analysis
The Crop Analysis tool has been improved to enable you to specify the width and 
height of the crop area.

Note:  Selecting a parameter enables you to preview the area you want to crop.

1. Select Setup>Operations Modes , or on the keyboard, press CMD+K.

2. In the Operation Mode Preferences dialog box, select the Define Area for Crop 
Analyze check box.

3. 3. In the W box (width, or x-axis) and in the H box (height, or y-axis), type a 
value from 40% to 100%

.

4. With the Preview window open, press SHIFT to display the image area 
designated for crop analysis.
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5. If you need to adjust the area for the crop analysis, press and hold the SHIFT 
key while pressing the up and down arrow keys. 

.

6. In the Setup dialog box, click Apply to perform the crop analysis.
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Automatic Crop Definition
Use the automatic crop definition option to automatically crop an area inside the the 
scan.

Working with automatic crop definition enables you to improve your scan workflow 
and also provides you with an automatic cropped area for use with the save preview 
feature and scan.

To enable automatic crop definition:

In the operation mode layout display window, select Automatic Crop Definition.

.
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Productive Reflective Scan
Note:  This feature is only available for iQsmart 2 and 3.

The productive reflective scan feature enables you to scan many originals with the 
same scanning parameters, such as enlargement, resolution, colors, and so on. In 
this workflow you can place several reflective originals on the scanning board, scan 
them as one image, and then subsequently scan additional sets of originals.

This workflow improves the scanning productivity.

1. Place your scan on the glass.

2. In the layout display, select Productive Reflective Scan.
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You can also enable the productive reflective scan by pressing ..+K and selecting 
Productive Reflective Scan.

3. In the layout display, define the desire scan area to be used for all your scans.

Notes: 

• The cropped area size will be applied to all scans in your workflow. You 
cannot change the cropped area after preview.

• If you place several originals on the scanning board, crop them after 
scanning using another application.

4. On the scan palette, click the Preview icon.

5. Set the desired parameters for the scan in the Setup dialog box. If desired, save 
the settings for future use.

Important:  When saving the setup settings, ensure that none of the parameters 
are saved as Custom.

6. On the scan palette, click the Scan icon.
The scan is performed.

7. Remove the image or set of images from the glass and replace with another 
image or set of images.

8. Scan the images using the same the scan parameters. No preview is available 
for subsequent images (or sets of images) scanned using the same parameters.

9. Repeat steps 7-8 for subsequent images in your workflow.

The scanner is calibrated for the first scan, and this calibration is then used for all 
other scans, until you close the application.

Tip:  To work with different settings—for example, scan size, resolution—use saved 
settings.



Quality Preview Option 63

Quality Preview Option
In some cases the image in a preview can appear misaligned. To prevent this from

happening, in the Operation Mode Preferences dialog box, select Quality Preview.

Note:  This option slows down the performance speed.

Note:  This option is only available in the iQsmart family.

.
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Overview
SOOM - Scan Once Output Many. With SOOM you can scan an original once in the 
oXYgen Scan application capturing all the detail in a pure 16-bit digital transparency 
file (DT file). This DT file becomes your digital transparency, which you can open 
from your disk in the oXYgen Open application, offline, and repurpose it for any use 
with all the professional image editing tools using the ICC workflow. 

The oXYgen applications optimize scanning by maximizing the scanner's potential. 
The applications are designed with strong emphasis on flexibility, quality, 
productivity and exact color reproduction. They provide a host of professional image 
editing and proofing tools with a highly intuitive, icon based, workflow-oriented 
interface.

When scanning pure 16-bit RGB DT files, you can select one of the two workflows:

• Split workflow 

The first stage in this workflow is to scan the images in the oXYgen Scan 
application to accurate file sizes without image manipulation. The second stage, 
image editing, is performed in the oXYgen Open application offline on one or 
more workstations. After editing, the images are saved as RGB Internet, RGB 
printer, or CMYK Printer files.

• Digital Archiving workflow

In this workflow, you capture the originals with maximum information and 
archive the images in the oXYgen Scan application. The archiving of the images as 
pure 16-bit RGB DT files is done by determining a file size according to the future 
use of the image. Then, you ‘scan’ the images using the ICC workflow in the 
oXYgen Open application.

Note:  In the oXYgen Open application, when you ‘scan’ the image, you process the 
high-resolution DT file and save it as an RGB or a CMYK file.
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The following diagram illustrates the oXYgen workflow.
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Scanning DT Files in oXygen Scan
When scanning DT files in the oXYgen Scan application, follow the sequence 
described in the following sections.

Setup Parameters
When scanning DT files, you can set all the crop, scale and resolution parameters. 
Additionally, you should embed a proper scanner profile to scan the image.

To improve the productivity, you can use the Direct Scan option, especially when 
archiving.

The following figure illustrates the Setup dialog box in the DT File mode.

Layout Display
In the Layout Display, select the images you want to send to preview.

For more information on Layout Display, refer to Layout Display on page 45.

Performing Preview
To perform a preview, click the Preview icon in the Scan palette.

For details on performing preview, refer to Performing Preview on page 48.
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Setup Dialog Box
After Preview, you can perform the following in the Setup dialog box:

1. Change the Scale value by entering a new value or using the Scaling tool.

2. In multi-preview with positive and negative originals, the selected Media might 
not be correct for the displayed Preview. In that case, choose the correct option, 
Positive or Negative.

Whenever the image can be updated, Apply becomes active. For example, after 
defining a crop, Apply performs a crop analysis and automatically selects new end 
points.

Note:  In the DT mode, the system performs analysis on each crop for preview purposes 
only. The analysis has no effect on the final scan.

Crop and Multi-Crop
Use the cropping tool to define a new crop. 

For details on crop and multi-crop, refer to Crop and Multi-Crop on page 69

Scan
The Scan function scans the image to the disk, resulting in a high-resolution image. 
The scan is performed according to the Setup dialog box settings and defined scan 
parameters. To view the scanned image, use the oXYgen Open application.

Note:  Saving a DT file creates one high resolution and one low resolution file for preview.

To scan the preview:

In the Scan palette, click the Scan icon.

The selected items are sent to the Scanner Queue window for scan. In the Preview 
Browser, a Scan icon with an arrow appears below the image thumbnail of the 
Preview (the arrow disappears after the scan). In multi-crop, all crops enter the 
Scanner Queue window as a group, and the Preview display window closes.

File Formats
When scanning DT files, the available file formats are TIFF.

To embed the input profile in the file, click Embed ICC Profile in the Scan dialog box, 
and check the With ICC Profile option.
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Retouching DT files
If you want to have a clean DT file, before opening the file in the oXYgen Open 
application, you need to retouch the original (master) file in Photoshop. To do that, 
you should have the DTFormat plug-in installed.

To retouch DT files, perform the following:

1. Make sure the DTFormat plug-in is installed in the Photoshop Plug-ins folder.

2. From the File menu, select Open. The Open dialog box is displayed.

3. Browse for the original you want to retouch.

4. In the File Format box, select DTFormat plug-in and click Open.

5. In the Profile Mismatch dialog box that is displayed, click Don’t Convert to open 
the original.

6. Retouch the original, and click Save.
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Working With DT Files in oXYgen Open
The oXYgen Open application enables offline reprocessing of DT files without a 
scanner. You can open the pure 16-bit RGB DT file and edit it using the ICC 
capabilities to produce a number of 8-bit and 16-bit files. In the oXYgen Open 
application, you can open all the files in your current job folder very fast. This feature 
enables you to start working on the images without delay.

To open a DT file, perform the following:

1. Enter the application, or restart it.

2. From the File menu, select Open. The Open DT File dialog box is displayed.

3. Browse for the folder where the images that you want to open are saved.

4. Select all the files you want to open, and click Open. All the selected images are 
sent to queue, and the previously scanned 
low-resolution previews are displayed. Each preview is displayed with the 
parameters it was scanned with.

To edit a DT file, perform the following:

1. Select one of the available modes: RGB, CMYK, B&W, color RGB 16 bit and 
B&W 16 bit.

2. Define the size, scale, and resolution parameters.

Note:  When you are scaling the image that has already been scanned, to maintain 
high quality, it is not recommended to enlarge the image more than twice its original 
size.
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3. From the Profiles list, select an input and output profile, or a device link.

Note:  Your list of available profiles depends on the mode you chose. For example, if 
you chose CMYK, it will show you only CMYK-type output profiles.

4. From the Setup dialog box, select an End Points, Gradation, and Sharpness table, 
or define your own parameters by clicking the relevant icon in the Image 
palette.

5. When you have defined scanning parameters for all the selected files, they 
enter the Scanner Queue window for scan, and the Scan dialog box is displayed.

In the Scan dialog box, do the following:

1. Enter the scan file name in the Save Scan as field. You can either use the default 
name or enter a new name.

2. Choose the file format. Available formats depend on the selected Mode. The 
selected format should be according to the application you intend to use with 
the scanned file. 

3. When you scan using ICC profiles, and you want to embed the profile, select 
either TIFF or EPSF format. Then, click Settings in the Scan dialog box, and 
check the With ICC Profile option.

4. Set the destination folder of the ‘scanned’ image.

5. Click Scan to send the item to the Scanner Queue window for ‘scan’.

Note:  In the oXYgen Open application, when you ‘scan’ the image, you process the 
high-resolution DT file and save it as an RGB or a CMYK file.
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Overview
This chapter is about color management, including:

• Using ICC workflows

ICC Workflows
The Scanning applications support ICC workflows giving you better control over the 
quality of the scanned images. ICC workflows can be used with transparent positive 
and negative 
CMYK/RGB images, and with reflective RGB/CMYK images. You can work with 
negative images only in the Device link mode.

When scanning with ICC workflows, you can use either input/output profiles or 
device link profiles. There are several ICC workflows to suit your scanning needs. 
Following is a description of the available workflows.

Scanning Images in RGB Mode Using Input/Output Profiles

Scanner RGB

Input profile: scanner profile; Output profile: NONE.

Select the input profile according to the selected image type (transparency/
reflective).

This mode preserves the color space of your scanner and allows you to view an 
accurate representation of the scanned originals on your monitor. Use this workflow 
when you want the image you are scanning to be printed on several output devices.

When you save the file in the TIFF or EPSF format, you can select to embed the 
scanner profile in the saved file. The scanner profile then becomes part of the digital 
file. Opening the image on any application will assure that you see an accurate 
representation of the scanner’s color space.
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RGB Color Space

Input profile: scanner profile; Output profile: RGB Color Space.

In this mode, you can scan images to one of the standard RGB color spaces. This 
workflow enables you to see what the image will look like when opened in another 
application that supports the ICC color management. 

When you save the file in the TIFF format, you can select to embed the RGB color 
space, such as Adobe RGB, in the scanned file. Opening the image on any 
application that supports ICC workflow will assure that you see an accurate 
representation of the colors.

Printer RGB

Input profile: scanner profile; Output profile: RGB printer.

In this mode, you can scan images to be printed on specific RGB printers. You can 
embed the RGB printer profile in the file, which enables you to soft proof the image 
on your screen. That is, you will see on the screen what the image will look like when 
printed. Use this workflow when working with a specific device.

When you save the file in the TIFF file format, you can select to embed the RGB 
printer profile in the scanned file.

Note:  The most suitable output RGB profiles are AdobeRGB1998 and ProPhoto RGB.icc
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Output Simulation

In the Color RGB mode, the Output Simulation option is available at the bottom of the 
Image display window. By selecting the Output Simulation option and an output 
profile from the Output Profiles list (to the right of the Output Simulation option), you 
can see how the file will be seen after printing by a specific printer. Also, you can see 
what the image will look like when printed on a selected output device.

The following figure illustrates the Image display window in the Color RGB mode 
when the Output Simulation option is selected.

Scanning in the CMYK Mode Using Input/Output Profiles
Input profile: scanner profile; Output profile: CMYK printer.

In this mode, you scan the images to the CMYK color space of a CMYK printer. You 
can see on the screen what the image will look like when printed. This workflow is 
recommended when you are working with a known CMYK offset standard, such as 
USSheetfedCoated, or a specific CMYK device having a specific output profile.

When you save the file in the TIFF format, you can select to embed the CMYK 
printer profile in the saved file.

Output Simulation option

Output Profiles list
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Scanning Images Using Device Link Profiles
A Device Link profile is a combined input and output profile from the scanner to a 
specific output device. It enables you to fine tune the transformation and improves 
your color quality control. 

To create a device link profile:

Select the appropriate input and output profiles and edit the profiles by using 
one of the editin.g tools (Color Correction, LS Curves, etc.). Then, save the 
combined profile as a new device link profile.

The Device Link list contains device link profiles and color tables. In the Device Link 
list, the profiles above the line are device link profiles; the color tables are below the 
line.

Note:  When you select a device link profile, it is displayed using the active ICC monitor 
profile. When you select a color table, it is displayed using the old Screen Match method.

If you want to use old color tables, you can add them to the Color Table list by 
dragging them from the Old ColorTables folder to the Tables folder.

Device Links in Scanning Negatives
When scanning positives, you can achieve a good representation of your original in 
the output device you are using by applying an ICC workflow. When scanning 
negatives, in order to get the inversion of your original, you should choose a proper 
device link and film type table in the Setup dialog box. Any device link used for 
positives can be used also for negatives.

In the Setup dialog box, select Negative under Media. Then choose a filmtype 
table that best suits your film type, and a device link that is a link between the 
color space of your scanner and output device.
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Overview
This chapter is about tone reproduction and performing tonal changes in image, 
including:

• Changing the White and Dark Points

• Adjusting exposure 

• Removing unwanted color cast

• Adjusting contrast

• Adjusting brightness

• Adjusting color balance

The Tone Reproduction function includes two main functions:

• End Points, for defining the effective density range of the original and removing 
color cast.

• Gradation, for further tonal adjustment (brightness and contrast) and for color 
balance. 
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End Points
This section describes the End Points function. During Preview, the scanner 
performs an image analysis of each crop and automatically selects the White and 
Dark Points. The White point is the whitest neutral point in the image with detail; the 
Dark point is the darkest neutral point in the image with detail. End points editing 
can be performed after Preview.

Show End Points
You can now have a visual indicator (end point marker) for white points and dark 
points selections with Show End Points. A yellow and a red icon appear when you 
activate Show End Points. These correspond to the lightest and darkest points 
respectively. In addition, 
a black circle icon might be displayed if a white point exists in the preview. The black 
circle icon represents the white point picked up by the system. 

If you manually set the white point, a different icon appears at the point you select. 
You can activate or deactivate this feature by clicking the Show End Points icon on the 
Preview window.
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Editing End Points
End Points editing is performed after Preview and after cropping. 

Note:  If you intend to use Crop Prescan, edit end points only after the Crop Prescan.

After Preview, click the End Point icon in the Image palette (or choose End Points 
from the Image menu in Menu bar). The End Points dialog box appears.

End Points editing is performed separately for White and Dark Points. In the 
dialog box, choose the White or Dark Point tab, depending on which point you 
want to edit.

White/Dark point controls

Note:  This section describes White point editing, but it applies to Dark point editing as 
well.

• You can manually select a new White point by marking it on the image, or by 
defining its density value.

• For White point only, you can use Neutralize to change the image color balance. 

• You can adjust the Cast Removal and Exposure. 

The above options are detailed below.
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Set White Pt

Set White Pt adjusts the brightness and color balance of the image.

See Image Correction Examples, Fig. 6: Removed cast & increased brightness.

Click the Set White Pt button. Using the picker, mark the White point on the 
image. You can view the values of the point in the Values section (see Values 
further on). If you want to choose another point, click the button again and mark 
a point. 

Note:  If you press the Shift key, you can pick several different points.

White Density

White Density changes the image brightness, without affecting the color balance. 

See Image Correction Examples, Figs. 1 & 2: Brighter highlights & increased contrast.

The top indicator in the White Density slider marks the density of the White point, 
according to the image analysis. The density value appears to the right of the slider. 

See Image Correction Examples, Fig. 4: Brighter highlights, color balance unchanged.

To change the density, move the slider or enter a new density value. The higher 
the White point density value, the lighter the highlights become. This may cause 
some details to be lost in the highlight areas.

Note:  The Dark point density listed below the slider is informative only. 

Neutralize (for White point only)

Neutralize changes the color balance without affecting the brightness.

See Image Correction Examples, Fig. 5: Remove cast without affecting brightness.

Click the Neutralize button. Using the picker, mark the point that you wish to use as 
a reference point for neutralizing the image. You can view the values of the point in 
the Values section (see Values below). 
If you want to choose another point, click the button again and mark a point.

Remove Cast

The top indicator in the Remove Cast slider is set to the system preference, used 
during Preview. For more cast removal, move the indicator to the right; for less cast 
removal, move the indicator to 
the left.

Automatic

Click Automatic to reset the White point to the automatic selection of the scanner. 
Previous changes, including neutralize and remove cast, are canceled. 

Automatic overrides the active End Points table.
Use the Sampler tool and Sample Points function to view your 
changes on selected reference points. 
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Values

Relevant when using Set White Pt and Neutralize (not relevant in Automatic). Press 
the Down arrow to open the Values section. 
The following values appear for the selected point: 

• Current CMYK values (RGB values for Color RGB mode)

• After CMYK values, based on the active LUT

The color patch shows the Current/After colors.

Relevant when CMYK values are shown in the Values section. Press the Down arrow 
to open the RGB Input section. This section lists the density values of the original, as 
if measured by a standard densitometer.

Exposure control

Exposure is used to change the image brightness after Preview. When you enter the 
End Points function, the slider is set at 5.0 for positives; the slider setting may be 
different for negatives. 

If the image is too bright, move the indicator to the left to darken the image, or enter 
a value lower than 5.0.

If the image is too dark, move the indicator to the right to lighten the image, or enter 
a value higher than 5.0.

For further corrections, use the Gradation controls. See Gradation on page 87.

Option buttons in End Points:

Tip:  Use the split screen feature to view the image before/after changes.

Apply Active after each change, to update the image.

OK Updates the current setting of White/Dark Points, saves 
changes and exits the function. The End Points field in the 
Setup dialog box is updated accordingly. See Selecting 
End Points Tables (previously in this chapter) for details.

Reset All Resets the White/Dark Points to Automatic, the 
Exposure to default 5, and Remove Cast to the set 
default. 

Save Saves the White/Dark Points density values in a table, 
taking into account exposure and cast corrections. This 
option is useful to override the image analysis or for 
rescan purposes. The application will add the prefix 
fixed_ to the entered name.

Cancel Cancels applied changes.
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Auto Image Analysis
Auto Image Analysis is used to adjust the image analysis results so that they suit 
your preferences. You can also change the default value for Remove Cast. 

This is an Expert mode option. It can be accessed only if you have checked the Expert 
mode option in the Operation modes dialog box under General Preferences, Setup 
menu.

Refer to Setup on page 147 for more information.

From the Expert Preferences menu under Setup, choose Auto Image Analysis. 
The following dialog box is displayed. 

The dialog box contains two sections: End Points (for Reflective and Transparent) 
and Remove Cast. See the following description.

End Points

Use End Points to adjust the automatic selection of the end points. That is, your 
changes are offsets from the normal automatic selection.

1. Press the requested tab: Transparent or Reflective.

2. Choose one of the End Points tables from the pop-up list. The selected table 
provides values optimized for the subject. 
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White/Dark Point Sliders

To customize the automatic selection by defining density values, which will 
consistently offset the values obtained from the image analysis. The N on the 
slider indicates the Normal (automatic) setting. You can move the slider, or enter 
the offset value (in density) relative to Normal in the input field to the right of the 
slider. The End Points field in the Auto Image Analysis dialog box becomes 
Custom. 

From Preview (active after Preview in current run)

To customize the automatic end points selection based on a reference Preview, to 
be used for future scans.

1. Preview the image you want to use as a reference. In Preview mode, select the 
End Points function.

2. In the End Points dialog box, manually select the end points or define their 
density values. For details, see Editing End Points in previous section. 

3. Click OK to save and exit.

4. In the Auto Image Analysis dialog box, click the From Preview button. The 
sliders are set according to the end points setting in the reference Preview, and 
the offset values (relative to the Normal option) appear. The End Points field in 
Image Analysis setup dialog box becomes Custom.

Note:  In the Setup dialog box, the End Points field shows AutoNormal if End Points in 
Image Analysis is Normal, and AutoCustom in all other cases.

Remove Cast

Sets the color cast removal preference. To change the default settings, set the sliders 
for transparent and reflective, for the highlights and shadows separately, or enter a 
value in the input field to the right of the slider. The value 0 means no cast removal; 
100 is maximum cast removal.

Saving End Points Tables

Use Save to save all of the changes you make in Auto Image Analysis. Every table 
saved here will have an Auto_ prefix. The tables can be used in the Setup dialog box 
in the End Points table.
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Gradation
Gradation is used for brightness, contrast and color balance adjustments, 
throughout the tone range of the entire image or in specific tone ranges. Gradation 
changes are performed after Preview and after end points editing.

Gradation Tables
Gradation in the Setup dialog box lists the name of the active Gradation table or 
Custom. 

You may apply another Gradation table, or edit the active table and save your 
changes. Gradation is an interactive function; that is.

The gradation Save option is used to create tables. The default table is G_Default@. 
You can modify the default table and save it under a new name, but you cannot 
overwrite it.

Custom is listed when gradation changes are not saved under a new table name, and 
is available only for the current run.

To apply another Gradation table:

1. In the Setup dialog box, press on the Gradation field to display the list of available 
Gradation tables.

2. Choose a table from the Gradation list.

3. Click Apply to update the image.
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Editing Gradation
You can edit the active Gradation table, listed in the Setup dialog 
box (you cannot edit G_Default@).

Click the Gradation icon in Image palette, or choose Gradation 
from Image menu in Menu bar. The Gradation dialog box appears.
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Gradation Graph

The horizontal axis represents the tone values of the image before gradation 
changes. The vertical axis represents the tone values of the image after gradation 
changes. All four separations (CMYK) are shown, but if they have identical curves, 
the graphs appear as if there is only one curve. 

Figure 1: Default curve: Input equals Output 

Note:  In Black/White mode, only the black separation curve appears.

Brightness

Brightens or darkens the image. Increasing brightness brightens the image and 
results in a concave brightness curve. Decreasing brightness darkens the image and 
results in a convex brightness curve.

Set the Brightness slider to the right to increase brightness or to the left to decrease 
brightness, 
or
Use the right nudge button to increase brightness by 1 unit, or the left nudge button 
to decrease brightness by 1 unit.

See Image Correction Examples, Fig.8: Brightness change.

The brightness value appears to right of the Brightness slider 
(values 0 - 100).

Contrast

Increases the image contrast, by making the highlights lighter and the shadows 
darker, or decreases the contrast by making the highlights darker and the shadows 
lighter.

Set the Contrast slider to the right to increase contrast (S shaped curve), or to 
the left to decrease contrast (inverted S shaped curve), or use the right nudge 
button to increase contrast, or the left nudge button to decrease contrast.

The contrast value appears to the right of the Contrast slider 
(values 0 - 100).

See Image Correction Examples, Fig. 9: Contrast Change.
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Cont Center

Contrast increases the image contrast mainly in the midtones. Using Cont Center, 
you can adjust where the contrast is mainly increased. To enhance contrast in 
highlights, the contrast center is shifted toward the highlights; to enhance contrast 
in shadows, the contrast center is shifted toward the shadows.

1. First set the image contrast, by adjusting the Contrast slider (see above).

2. Then use Cont Center to adjust where the contrast is mainly increased: set the 
Cont Center slider to the right to enhance contrast in highlights, or to the left to 
enhance contrast in shadows, or
Use the right nudge button to enhance contrast in highlights. Use the left nudge 
button to enhance contrast in shadows.

Your change affects the gradation graph by moving the point where the curve 
changes from convex to concave.

Separation Controls

Specify the active separations, which means the separations affected by gradation 
editing. Choose one, more or all separations. Choosing a specific separation and a 
specific gradation control enables changing the color balance for a specific tonal 
range. 

See Image Correction Examples, Fig. 10: Single separation change

Show All

Check this box to display all the separation curves in the gradation graph, and not 
just the selected ones.

Gradation Controls

The gradation controls are used to adjust brightness in specific tone ranges. The five 
gradation controls are: Strt, Hlt, Mid, Shd, End. The Up/Down nudge buttons 
increase/decrease the graph value of the active separation(s) for a specified section.

If only one separation is active, the gradation (tone) value is listed, ranging from 0 to 
99. Otherwise, “—” is displayed.

Strt (Start)

Moves the point of origin of the curve at the highlight end along the horizontal or 
vertical axis.

Up button All points between 0 and 15 might increase. 
Increments become smaller as the points progress 
toward shadows. Highlights are darker, reducing global 
contrast.

Down 
button 

All points between 0 and 15 might decrease. Changes 
become smaller as the points progress toward the 
shadows. Highlights are lighter, increasing global 
contrast.
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Hlt (Highlight) (1/4 tone)

Changes brightness mainly in the highlights.

Mid (Midtones)

Changes brightness mainly in the midtones.

Shd (Shadows) (3/4 tone)

Changes brightness mainly in the shadows. 

End

Moves the endpoint of the curve at the shadow end along the horizontal or vertical 
axis.

Option buttons in Gradation dialog box:

Up button Darkens highlights, resulting in a convex curve.

Down 
button

Lightens highlights, resulting in a concave curve.

Up button Darkens the image, resulting in a convex curve. 
Brightness increases from highlights to midtones; 
decreases from midtones to shadows.

Down 
button

Lightens the image, resulting in a concave curve. 
Brightness decreases from highlights to midtones; 
increases from midtones to shadows.

Up button Darkens image, resulting in a convex curve.

Down 
button

Lightens image, results in a concave curve.

Up button All points between 100 and 85 might increase. 
Increments become smaller as points progress toward 
highlights. Shadows are darker, increasing global 
brightness.

Down 
button

All points between 100 and 85 might decrease. 
Changes become smaller as points progress toward 
highlights. Shadows are lighter, reducing global 
brightness.

Save Saves the Gradation settings in a table. You should 
save the table in the default tables folder.

Reset Sep Resets the Gradation dialog box settings. The gradation 
curves are displayed in a straight 45° line, and the 
Brightness, Contrast and Cont Center values are 50.

OK Updates the current Gradation table and exit the 
function. The Gradation table, listed in the Setup dialog 
box, becomes Custom.
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Toning Feature
Toning enables you to manipulate image tone according to your specific 
requirements. On the Toning tab of the End Points dialog box, you can save tone 
corrections together with White Point and Dark Point changes as an End Points 
table. You can make changes to each of the R,G, and B channels separately, or 
simultaneously to all.

Recommended Workflow
1. Preview the image you want to change.

2. Click the End Points button.

3. In the End Points dialog box, on the White Point tab, click the Set White Pt 
button.

4. Click the point on the image where you want to set the white point.

5. Click Apply.

6. On the Dark Point tab, click the Set Dark Pt button.

7. Click a point on the image where you want to set the dark point.

8. Click Apply.
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Adjusting the Tone Curve

To adjust image tone, use one of the following methods:

1. Drag the tone curve according to your requirements.

2. In the Preview window, click the image in the area you want to change, and then 
drag the tone curve or enter a new Output value.

To view your changes in the Preview window:

1. Click Apply.

2. If you want to save changes in an End Points table, click Save.

3. Click OK.

Note:  It is recommended that you make only a minor change to the position of the point.

Note:  This feature is only available in Positive Mode.
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Options for Reverting Tone Curve Changes
• Reset: All separation curves are reset to the position they were in when you last 

opened the Toning tab.

• Linear Curve: Select Red, Green, or Blue, and then click Linear Curve to reset the 
curve of the selected separation to a straight line at a 45 degree angle.

• Auto All: The AutoNormal@ table appears in the Setup dialog box. Automatic 
analysis of the image is made according to this table, and then toning changes 
are applied.

Important:  Drastic toning changes may damage the image file. Keep changes to a 
minimum.
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This chapter is about the color and gray controls, including:

• Selecting and applying Color profile/Device link.

• Color Correction; includes intuitive HSL and CMYK controls for performing 
color corrections. You can control the range of colors that will be affected.

• LS Curves; performs color corrections in an image by modifying the luminance 
and the saturation values of a selected color.

• Color Correction Mask; for interactive editing, allows you to see the color 
corrections on the preview.

• Gray Control; modifies the gray balance by changing the CMYK values of the 
grays.

• Input Gray Levels; modifies the RGB values of the White/Dark points and 
midtone of the Color profile/Device link, thus changing its contrast.

• Separation setup; includes the UCR/GCR/UCA functions.

Color Correction
The Color Correction function enables you to change the colors of an image. The 
requested color is selected and changed using the HSL and CMYK controls. When 
one of the controls (HSL, CMYK or RGB) is modified, the other control is 
automatically updated. In addition, you can control the range of your color 
correction.

1. Click the Color Correction icon in the Image palette, or choose Color Correction 
from the Image menu in Menu bar. The Color Correction dialog box is displayed.

Note:  The HSL color palette in the dialog box is empty until you select a color.

The Color Correction dialog box has two tabs: Selective and Global:

• Selective provides a good solution for most situations. You can pick and choose 
specific colors from the image that you can change in a highly selective manner.

• Global offers a choice of preset color ranges that are depicted by color-coded 
buttons. Each of the buttons represents a specific color group. For example, if 
you press the green button and you make a change, all the greens will be 
affected. Global is used to correct color in a broad and general way.

2. Select the tab(s) that most suit(s) the method with which you would like to 
effect color correction. If you intend to use both Selective and Global, to achieve 
optimum results, always use Global first.
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3. For Selective, using the picker, select a color from the image. 
The dialog box is updated with the selected color, as shown in the following 
figure.



98 Chapter 8—Color Editing

 

For Global, using the cursor, select the color coded button that represents the 
range of colors you want to correct. The dialog box is updated with the selected 
color.

Note:  The Table field in the Color Correction dialog box lists the name of the active Color 
table.

The controls of the Color Correction dialog box are described further on.
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HSL color palette

This section includes the HSL color corrections (from right to left):

• Basic hue control. The white frame marks the area with the hues that are closest 
to the selected color; this area is enlarged in the Fine hue control. The selected 
color is located in the middle of the frame area. The colors shown in this slider 
reflect only hue changes (saturation and luminance are fixed). This control is 
used for major interactive hue changes.

• Fine hue control is a magnification of the hue area of the selected color (the area 
framed in the Basic hue control). The colors in this control reflect hue, saturation 
and luminance changes. This control is used for fine interactive hue changes.

• H, S, L numeric input fields show the selected color values. This control is used for 
fine numeric hue, saturation and luminance changes.

• Luminance/Saturation control, where the luminance is the vertical axis and the 
saturation is the horizontal axis. The small circle marks the selected color. This 
control is used for interactive saturation and luminance changes.

CMYK Controls

• CMYK before/after values. This control is used for fine numeric CMYK changes. 
These changes affect the HSL controls.

• CMYK before/after color patches of the selected color (before changes the 
before/after are identical). These patches reflect any color change you perform.

The colors shown in the HSL and CMYK controls represent the colors of the active 
profile. Color corrections are performed by modifying the above controls.
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To perform Color corrections, perform the following:

1. Select Color Correction to open the Color Correction dialog box.

2. Select either the Selective or the Global tab. 

3. In Selective, pick a color from the image; in Global, click one of the color buttons.

4. Change HSL values visually with the Basic hue, Fine hue and Luminance/
Saturation controls.

See Image Correction Examples, Figs.12, 13 & 14: Color corrections with default range.

5. Change HSL values numerically with the HSL numeric input fields.

6. Change CMYK values with the CMYK controls.

In some cases, a combination of the above controls is required to achieve the 
desired result. When the HSL or CMYK controls are modified, the other controls 
are updated accordingly. 

7. To perform major hue changes, move the frame of the Basic hue control.

8. To perform fine hue changes, move the marker of the Fine hue control.

9. To perform saturation and luminance changes, move the circle of the 
Luminance/Saturation controls. Moving toward the right increases saturation; 
moving downward increases luminance.

Tip:  To view changes before Apply, click the After box. When you move to the display 
window, a patch in the After color is displayed. Place the patch to view the color change.

Tip:  For fine saturation/luminance changes use the numeric input fields.

Alternatively, or in addition, you can enter new values in the HSL numeric input fields. 
This method might be more suitable for fine changes. Value ranges are:

• Hue: 1 - 360

• Saturation: 1 - 128

• Luminance: 1 - 255

10. To change the CMYK values, enter new values in the After fields or use the 
CMYK nudge buttons. The After color patch is updated accordingly.

You can use a combination of the above controls. You can also change the Range 
option (as described below) while performing your color corrections. 

Tip:  Use the Sample points function to view you changes.

Range

The Range control defines, in HSL values, the effective range of 
your color changes. In other words, it defines which hues, 
saturation/luminance levels will be affected by your change. R_Default@ is the 
default Range setting; additional settings are supplied for other changes.

1. To change the default range setting, choose one of the supplied settings from 
the Range pop-up list.

2. You can also create custom-made ranges by setting the Range controls. Press 
the Range arrow to display the Range controls.
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The Range controls include the Hue, Sat and Lum sliders (modifying one slider does 
not affect the other sliders). The marker on each slider indicates the selected color.

To create custom made ranges:

If you cannot achieve the desired effect with the existing ranges, you can create your 
own range settings. Since range is independent, changing its controls does not affect 
the HSL/CMYK controls.

1. Set the Hue, Sat and/or Lum sliders, by moving one or both controls of each 
slider you want to modify. When the two slider controls are set closer together, 
the range effect is more limited.

See Image Correction Examples, Figs.16, 17 & 18: By adjusting the Range controls, you 
can adjust the specific blues that will be affected.

Note:  As you modify the HSL sliders, the Range field becomes Custom

2. Use the range Save button to save custom Range settings. The saved file 
contains the offset values relative to the current selected color. When a new 
color is selected, the saved relative offsets are loaded and applied to the new 
color.

The effect of applied color changes depends on the scope of the change and on the 
Range. For example, if you perform a major change, but the Range is very limited, 
then your change will mainly affect the selected color, but hardly affect other colors. 

Option buttons in Color Correction:

Note:  Each of the option buttons effects changes in both tabs, Selective and Global.

Tip:  Use the split screen feature to view the image before/after changes

Apply Active after each change, to update the image.

OK Updates the current image and exits the function.

Reset Last Cancels the last Apply, that is, the most recent change 
that was applied to the image.

Save Saves color changes as a Device link profile.

Reset Cancels all changes.

Cancel Cancels all changes and exits the function.
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LS Curves
The LS Curves function enables you to perform color corrections in 
an image by modifying the luminance and the saturation values of a selected color.

Click the LS Curves icon in the Image palette or select LS Curves from the Image 
menu.

The LS Curves dialog box is displayed.

Color palette

Use the Color palette icons for global color changes for each color (separately).

All Colors

Use the All Colors icon for global color changes for all colors.

Picker

Use the picker to select a color/to mark a reference point in an image.
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Luminance/Saturation controls

The LS Curves dialog box has two tabs, Luminance and Saturation. Select Luminance 
when you want interactively to brighten or darken the image along the luminance 
axis. Select Saturation when you want to change the colorfulness of the image, i.e. 
to neutralize the colors in the image or make them more colorful.

Include Grays

Use the Include Grays option to apply the color changes also to gray colors. This 
option is available only when making color corrections to all colors.

Reset

The Reset icon, at the top left corner of the LS Curves Graph dialog box, cancels 
changes applied to the curve. The Reset button, at the bottom of the dialog box, 
cancels all the changes made in the LS Curves dialog box. The Reset Last button 
cancels the last change made in the LS Curve dialog box.

LS Curves Graph

The horizontal axis represents the luminance/saturation values of the image before 
the color changes (input). The vertical axis represents the luminance/saturation 
values of the image after the color changes (output). When the Luminance tab is 
selected, the more you drag the anchor point(s) upwards, the brighter the image 
becomes. When the Saturation tab is selected, the more you drag the anchor 
point(s) upwards, the more saturated the image becomes.

Ranges control

The Ranges control includes the Hue and Luminance/Saturation sliders. Each slider 
has a marker that indicates the selected color.

Ranges control for Luminance

The Ranges control for luminance defines, in hue and saturation values, the effective 
range of your color changes. In other words, 
it defines which hues and saturation levels will be affected by your change.

Ranges control for Saturation

The Ranges control for saturation defines, in hue and luminance values, the effective 
range of your color changes. In other words, 
it defines which hues and luminance levels will be affected by your change.
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Color Correction Mask
Color correction mask gives you control over the exact pixels in the image on which 
you want to make color corrections. This tool is convenient for interactive editing, i.e. 
it allows you to see the color corrections on the preview immediately, before 
applying the changes.

Color Correction Mask icon appears on the toolbar along the left side of the Image 
display window.

Perform your color corrections, then click the Color Correction Mask icon. 

The pixels in the image that were affected appear in the complementary color. If 
no additional color correction is needed, click Apply to update the changes.

To switch between the mask view and the regular view, click Color Correction 
Mask icon again.

Performing Color Corrections
The Color Correction and the LS Curves function used together with the Color 
Correction Mask tool offer you an interactive tool for color editing. It gives you full 
control over the exact colors to which you want to apply the change.
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To perform color corrections in an image:

1. Select a color from the image using the picker; an anchor point is displayed in 
the curve.

2. Drag the anchor point(s) upward if you want to brighten the image, or make it 
more saturated. Drag the anchor point(s) down if you want to darken the image 
or make it more neutral.
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3. Click the Color Correction Mask icon in the Image display window to view the 
pixels that were affected by the change you made.

Note:  You can use split screen to view the image with or without the mask.

4. Use the Ranges control (Hue and Luminance/Saturation sliders) to limit the 
effect only to the exact colors you want to change. Set the Hue and/or the 
Luminance or Saturation sliders by moving one or both controls of each slider 
you want to modify to broaden or limit the range effect.
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Gray Control
Gray balance is important for obtaining good printing results. It is necessary that the 
gray balance of the Color profile/Device link matches the gray balance of your 
printing system. Gray Control modifies the gray balance of the Color profile/Device 
link by changing the CMY (output) values for the grays. The values and shape of the 
black (K) curve are also controlled. Changes affect the grays and unsaturated colors.

The grays are defined by several Control points, three main points and four 
secondary ones. It is recommended to have the values of the Control points of your 
printing system when using Gray Control.

From the Image menu, choose Gray Control. The Gray Control dialog box is 
displayed.

Note:  This feature is only available in CMYK mode.

Gray Control includes the following:

• Separation curves of C, M, Y and K values along the gray axis of the Color 
profile/Device link. These curves change interactively as you edit the Gray 
Control parameters.

• Mode determines the number of Control points you wish to edit. Choose one of 
the following:

3-Points includes three main points (White point, Dark point and midtone).

Note:  Black Start Pt, Black Contrast and CMY Contrast are available only in this 
mode.

More Points includes the three main points (White point, Dark point and 
midtone) and four secondary points (CatchLight, 1/4 Tone, 3/4 Tone and 
Solid Black). 
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In 3-Points, the curves are always smooth; in More Points, the curves may be 
unsmooth. When changing to 3-Points, the curves become smooth without 
affecting the White/ Dark points and midtone values.

• Black Start Pt [0 - 90]

In 3-Points only, this parameter sets the cyan value from which black appears. 
For example, if Black Start Pt = 20, then for any gray point with cyan value above 
20, the black value is above 0.

• Black Contrast [-100, 100]

In 3-Points only, this parameter sets the rate of change of the black separation 
along the gray axis. Positive/negative values indicate an increasing/decreasing 
rate of change.

• CMY Contrast [-100, 100]

In 3-Points only, this parameter sets the rate of change of the CMY separations 
along the gray axis. High/low values indicate an increasing/decreasing rate of 
change.

• Effective Range [0 - 100]

Determines the effect of changes on other colors of the Color profile/Device link. 
The higher the range value, the more saturated colors are affected. For range = 0 
(min.), only the grays are affected. For range = 100 (max.), all colors are affected.

• CMYK values of Control points

The number of active Control points depends on selected Mode option. The 
CMYK values of the control point affects the gray control curves.

Using Gray Control:

1. From the Mode pop-up list, choose 3-Points or More Points, depending on the 
number of Control points you wish to edit.

2. Check the requested CMYK values of the Control point and edit them. For a 
correct gray balance, you should enter the values of your printing system.

3. Select and edit additional Control points, as necessary.

Tip:  Use the Sampler tool and Sample Points function to view your changes on 
selected reference points.

4. Verify the Effective Range value.

5. For 3-Points only, you can define the Black Start Pt value and edit the CMY/
Black Contrast values of the CMY and black separations.

6. To use a reference point while performing changes, click the Reference point 
arrow. The following window is displayed.
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7. Using the picker, mark a reference point on the image. You can now evaluate 
changes before Apply, by viewing the CMYK Orig/New values and color 
patches.

Tip:  To view changes before Apply, click the New box. When you move the pointer 
to the Image display window, it drags a patch in the New color.

Option buttons in Gray Control:

Note:  Use the split screen feature to view the image before/after changes.

Apply Active after each change, to update the image.

OK Updates the current image and exits the function. 

Reset Cancels all applied changes.

Save Saves color changes as a device link profile.

Cancel Cancels all changes and exit.
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Input Gray Levels
Input Gray Levels controls the number of gray levels below and above the White 
and Dark points, and affects the Color profile/Device link contrast.

The grays are arranged on the RGB axis, ranging from 0 to 255. Editing the RGB 
values of the White and Dark points changes their position on this axis, thus 
affecting the number of gray levels below the White point and above the Dark point.

The range between the White and Dark points is divided by the midtone into 
highlights and shadows. Therefore, changing the RGB value of the midtone affects 
the Color profile/Device link contrast.

This function is useful in special cases, when the required amount of gray levels 
beyond the end points is non-standard.

For example, reflectives that do not have values brighter than the paper base, where 
the current White point values are 3%C, 2%M, 2%Y and 0%K. You can move the 
White point slider until the values in the White point After fields are 0,0,0,0.

From the Image menu, choose Input Gray Levels. The Input Gray Levels dialog 
box is displayed.

RGB slider

The RGB slider (top of the dialog box) shows the RGB values of the White point (at 
the right end), Midtone (in the middle) and Dark point (at the left end).

The permitted range of RGB values for each point:

• Dark point range is 0 - 75. Default is 16.

• Midtone range is 90 - 165. Default is 128.

• White point range of 180 to 255. Default is 240.

Note:  Increasing the RGB values of the points makes the picture brighter; decreasing 
the values makes the picture darker.
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CMYK Before/After values

The CMYK Before/After values of the Dark point, Midtone and White point appear 
below the RGB slider. Within each point, and for each separation, the number on the 
left is the before value; the number on the right is the after value.

In most cases, you should verify that the RGB values of the White/Dark points 
and midtone are set to their defaults.

If you need to edit the RGB values, use the controls of the RGB slider: move the 
indicator, use the nudge buttons or enter the value in the input field. The CMYK 
After values change interactively.

Tip:  Use the Sample Points function to view your changes on selected reference 
points.

Option buttons in Input Gray Levels:

Tip:  Use the split screen feature to view the image before/after changes.

Apply Active after each change, to update the image.

OK Updates the current image and exits the function. 

Reset Cancels all applied changes.

Save Saves color changes as a device link.

Default Resets RGB values to their default values (listed 
previously). The CMYK values are also set to their 
defaults. Click Apply to apply the defaults.

Cancel Cancels all changes and exit.
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Separation Setup
Separation Setup includes the UCR, GCR and UCA functions.

When cyan, magenta and yellow separations are printed, the two significant colors 
of CMY determine the hue, that is, the basic color, such as red, blue, etc. The least 
significant color of CMY determines the saturation or grayness; it does not add color. 
In other words, at certain values of CMY, the cyan, magenta and yellow separations 
contain gray. Therefore, we can substitute percentages of black for the three process 
colors.

The UCR/GCR/UCA functions are non-interactive, that is, you can see the results 
only in the final scan, not on display. However, the densitometer values reflect these 
functions.

UCR (Under Color Removal)

UCR replaces a certain amount of CMY with black, and affects mainly the neutral 
(gray) colors of the Color profile/Device link.

GCR (Gray Component Replacement)

GCR performs the same function as UCR, but affects most of the colors (neutrals 
and colors) of the Color profile/Device link. Saturated colors are not affected.

The gray component in all colors is calculated and replaced with black. That is, a 
certain amount of the process color (C, M or Y) that has the gray component is 
replaced with black. As a result, although all three process inks are used, lower 
values of CMY and higher value of black are required.

UCA (Under Color Addition)

Using UCR/GCR can cause some loss of density and contrast in the shadows. UCA 
compensates for this loss by adding some of the color that was removed in UCR or 
GCR.

UCA can also be used to change the color balance in the shadows.

Note:  If UCR, GCR and/or UCA is selected, a U or G and/or A is displayed in the Image 
display window.

UCR/GCR Advantages
• Better color saturation

• Sharper reproduction due to detail in black separation

• Vivid colors even on poor quality paper

• Reduction in the consumption of expensive CMY inks

• Shorter drying and make-ready time on press

• Fewer ink trapping problems

• Higher stability of neutral tones (grays)
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Using UCR/GCR
1. From the Setup menu in Menu bar, choose Separation Setup. The Separation 

Setup dialog box is displayed.

2. Depending on your choice, choose UCR or GCR. To scan without UCR or GCR, 
choose Off.
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Separation curves

The CMYK curves along the gray scale of the active Color 
profile/Device link are shown. These curves change interactively as you edit the 
parameters described below (the densitometer values also reflect these 
parameters).

Note:  These parameters are inactive if OFF is selected.

Black Start Point [0 - 90]

UCR/GCR is applied only if the black value that will replace the gray component is 
above the Black Start Point. The higher this value is, the less effect UCR/GCR will 
have.

Maximum Black [0 - 100]

The maximum percentage of black in the Dark point.

Old Ink

Informative only. Displays the C+M+Y+K values of the Dark point in the Color 
profile/Device link, before performing UCR/GCR.

See Image Correction Examples, Figs. 20 & 21: Two examples of GCR.

Ink Coverage [100 - Old Ink value]

The desired amount of ink coverage (that is, C+M+Y+K values) of the darkest point 
in the Color profile/Device link after performing 
UCR/GCR.

Percent [0 - 100]

The percentage of the gray component that is reduced from CMY. 
In UCR, if Percent = 100 then all gray values are replaced by black.

Note:  Percent and Ink Coverage are related; if one is defined, there is no need to define 
the other. Ink Coverage is usually used in UCR, and Percent in GCR.

Using UCA
After performing UCR/GCR, you may use UCA to increase the density and contrast 
in the shadows that were affected by the 
UCR/GCR function.

UCA may also be used as a stand-alone function without UCR/GCR, when you want 
to change the color balance in the shadows.

1. Select the UCA option to display the UCA basic parameters.

2. Set the UCA parameters, as described below.
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UCA Start Point

Determines the starting point for UCA; this should be a point in the shadows. The 
area from this point toward the shadows will be affected by the UCA function.

Strength

The strength of the UCA effect. If set at 100, UCA has maximum effect, thus 
canceling the entire effect of UCR/GCR. For low values of strength, UCA has 
minimal effect.

See Image Correction Examples, Fig. 22: Using GCR with UCA.

Extended

Check the Extended option, if further fine-tuning is required (in addition to the 
Strength value).

In the UCA Extended field, set the CMYK values of the Dark point.

Note:  UCA is defined for a particular setting of UCR/GCR, so the UCR/ GCR parameters 
are grayed when UCA is used. To modify UCR/GCR, you must first uncheck UCA.

After setting the UCR/GCR/UCA functions, click OK. The settings will be 
applied to the device link in the final scan.
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Overview
This chapter describes:

• the Sharpness function

• the Sharpness controls

• editing Sharpness

During the scanning and printing processes, the picture sharpness is decreased. The 
Sharpness function compensates for this sharpness loss. Sharpness is applied 
automatically by the scanner, and can also be adjusted by the user.

The scanner increases the picture sharpness by comparing the light intensity of 
each pixel to the light intensity of its surrounding area:

• If the pixel is darker than the surrounding pixels, the scanner darkens it more to 
achieve a sharper contrast.

• If the pixel is lighter than the surrounding pixels, the scanner lightens it more to 
achieve a sharper contrast.

• If the light intensity of the pixel is the same as that of the surrounding pixels, no 
action is taken.

Sharpening affects the borders between adjoining areas of different brightness. 
After sharpening, a thin outline (contour) composed of a light and dark strip 
emphasizes the border between the lighter and darker areas. The following figure 
illustrates the results of sharpening.

Before After
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Sharpness Controls
The Sharpness function includes several controls that may be edited. The controls 
are located in the Sharp dialog box and include: 

• Basic controls

• Extended controls 

Basic Controls
The Basic controls determine the global sharpness level. To access the basic 
controls, click the Basic tab in the Sharp dialog box.

Format and Scale are described in Sharp Setup on page 125

Sharp

The Sharp control defines the strength of the contours produced by the Sharpness 
function, relative to the background. Sharp ranges from 0 (no sharp) to 10 (max 
sharp). 

See Image Correction Examples, Figs. 23 & 24: Changing the Sharp control.

Smooth

The Smooth control defines the degree of smoothness for the selected Sharp level. 
Smooth ranges from 0 (no smooth) to 10 (max smooth). 

See Image Correction Examples, Figs 25 & 26: Changing the Smooth control.
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Extended Controls
The Extended controls include controls that define the global sharp level. Editing 
these controls requires advanced knowledge about the sharpness function, and is 
recommended for experienced users. 

Note:  The Basic and Extended controls affect each other.

To access the extended controls, press the Extended tab in the Sharpness dialog box. 

Filter 

Filter defines the color channel used as a reference for image sharpening. In single 
color filters, the RGB channels are sharpened according to the brightness variation 
of the single channel. Therefore, the colors are not sharpened in the same degree.

In Green, sharpening is according to the green channel variations; the red and blue 
channels are modified accordingly. 

In Red-Green, the red and green channels are sharpened, each according to its 
variation, and the blue channel is sharpened according to the green channel. 

In All, all colors are sharpened in a balanced form, since each channel is sharpened 
according to its brightness variation. 

See Image Correction Examples, Figs. 27 & 28: Changing the Filter control.
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Radius

Radius defines the thickness of the contour produced by sharpness. The higher the 
radius, the thicker the contour. Radius ranges from 2 for thin contours to 13 for thick 
contours. The selected Radius affects the active Effect options (see Effect below).

See Image Correction Examples, Figs. 29 & 30: Changing the Radius control.

Effect

Defines the sharpening effect on the texture. There are a total of five Effect levels, 
but the active options depend on the Radius selected previously.

In Harsh, the sharpening enhances small texture details. In Smooth, the sharpening 
shows only large details. Intermediate options are Harsh-Med, Medium and Med-
Smooth.

Intensity

Determines the extent of the contours, produced by the Sharpness function, relative 
to the background. Intensity is set separately for the highlights and the shadows:

• Hlt for white contour

• Shd for dark contour

Intensity ranges from 0 - No Sharp to 10 - Max Sharp. The higher the value, the 
stronger the contour. That is, a larger difference between the contour and 
background. In Hlt = 0 and Shd = 0 there is no sharpening.

Grain

Grain is seen in the image when the emulsion particles of the film are visible at 
certain enlargements. The Grain control reduces the grain sharpness, that is, pixels 
within the grain are sharpened less than the rest of the picture. The surface then 
appears smoother and more even. Grain includes two separate controls, each 
ranging from 0 to 10:

Note:  A high Grain value might decrease the global sharpness.

Threshold Amount of pixel variation in the background, below 
which the effect is considered grain, and above which is 
considered texture or edge. The higher the threshold, 
the larger the differences that are considered grain. 

Value Amount of sharpness reduction performed on the area 
that is considered grain, relative to the background. The 
higher the value, the more reduction performed.
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Clip

A certain combination of two colors, such as blue and brown and a particular Filter, 
can create a noticeable contour. Clip can reduce these contours. In other words, Clip 
limits the extreme levels of brightness or darkness of contours produced in strong 
levels of Intensity. The extent of clipping is set separately for the highlights and 
shadows, thereby enabling independent reduction of the bright and dark contours.

Clip ranges from 0 - No Effect to 10 - Full Effect (no sharpening).

See Image Correction Examples, Figs. 31 & 32: Changing the Clip control.
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Editing Current Scan
Editing Sharpness in current scan is one of the methods for editing Sharpness 
(Sharp Setup is the second method, see further on).

Editing sharpness for current scan includes:

• Applying Sharpness tables

• Interactive Sharpness editing

Applying Sharpness tables
Sharpness is applied to the image using Sharpness tables. Several such tables are 
supplied with the application and S_Default@ is the default table. Additional tables, 
based on the default table, provide different effects. For example, smoother or 
sharper effects.

To apply another Sharpness table to the active displayed crop:

1. In the Setup dialog box, open the Sharpness pop-up list and choose one of the 
listed tables. If you do not create Sharpness tables, only the supplied ones are 
available.

2. Click Apply to update the image.

Interactive Sharpness Editing
After Preview, you can edit the active Sharpness table. Changes apply to current scan 
only, that is, to the current Format, Media and Scale. Interactive sharpness editing is 
possible only in Max Detail, so you should first perform a max detail prescan. In 
addition, you can see the effects of smoothening (descreening and anti-alias) on the 
max detail display. 

Performing Max Detail

Max Detail is a prescan of a limited image area in the final scan resolution. This 
option is useful when you wish to examine the results of Sharpness, and/or 
interactively edit the sharpness controls. You can apply sharpness changes to the 
max detail image, and evaluate the results.

1. In the Preview mode, when the Preview or Crop Prescan image 
is displayed, click the Max detail icon in the toolbar.
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2. Move the pointer to the Image display window.

The Max detail pointer is surrounded by a frame that marks the area that will be 
scanned in Max Detail. The frame size depends on the Scale and Resolution 
values defined in the Setup dialog box.

3. Position the Max detail pointer on the image area that you wish to see in 
maximum detail.

4. You can slightly modify the frame size and thereby the size of the Max Detail 
area. To increase or decrease the frame size, press the < > key together with 
the <+> or <-> key.

5. Double click to activate Max Detail on the defined area.

The max detail request is sent to the Scanner Queue window. It enters the top of 
queue and is performed when the current scan is completed.

The scanner performs a high-resolution scan of the frame area, using the final 
scan resolution and focus. When completed, an image thumbnail of the max 
detail appears in the Preview Browser, with the Preview or Crop Prescan name and 
the Max detail icon.

Note:  There can be only one max detail per crop. The first max detail is deleted if 
you request another one.

6. To display the Max detail image, double click its thumbnail in the Preview 
Browser. The Max Details window is displayed.

Note:  The cropping tools are inactive.

Note:  Use Split Screen to view the before/after changes.

Effects of Smooth

In some cases, when a certain amount of digital descreening is required, Smooth 
may be used. The jagged edges of lines are smoothened, and the dot pattern in 
printed material is blurred. The unwanted effects of moiré are also reduced.
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The effects of smooth can be viewed on the max detail image. Printed material is 
described in Chapter 8, Special Workflows. The following describes the use of smooth 
for jagged edges in lines.

1. If required, choose Anti-alias norm or Anti-alias strong from the Smooth pop-
up list in the Setup dialog box.

2. Perform a max detail prescan, as described in previous section.

The max detail automatically shows the effects of smooth and the queue is 
suspended. If the results are unsatisfactory, you can immediately repeat the max 
detail:

1. Choose another value from the Smooth list.

2. Click Show in the Setup dialog box to repeat the max detail.

The system rescans the max detail area with the new smooth value, and the new 
max detail replaces the previous one.

Sharpness Editing in Max Detail

The max detail image is automatically displayed with Sharp Effects active, so you 
can examine and edit the sharpness.

1. In the Image palette, click the Sharp icon. The Sharp dialog box is displayed.

2. Click the Basic or the Extended tab, depending on the scope of editing you wish 
to perform. 

Refer to Sharpness Controls on page 119

3. Edit the Sharpness controls.

4. Click Apply to update the image and view results.

5. Click OK to update the active table. The changes affect the current scan only 
and are not saved. The table becomes Custom.

6. Click Save to save changes in a new table for future use. 

Note:  To overwrite the S_Default@ table, you must first save it under a new name.

7. Click the Hide Sharp Effects tool to hide the sharp results.

Note:  This tool is active only in Max detail.

Sharp Setup
Sharp Setup is another method for sharpness editing, and is used for extensive 
editing of the Sharpness tables. Sharp Setup enables you to create and modify 
Sharpness tables for all Format and Scale categories. Changes are saved in the table 
for future use. 
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Format options include:

• Positive

• Negative

• Reflective

• Reflective Descreen

Each Format/Scale category contains a specific setting of the Sharpness controls: 
Intensity, Grain, Radius, Filter, Effect and Clip (described previously in Sharpness 
Controls on page 119).

1. From the Setup menu, point to Sharp Setup, then select General. The Line-art 
option is selected in the Line-art mode.

Refer to Line-art Mode on page 138.

2. In the Sharpness dialog box, click the Basic or Extended tab, depending on the 
scope of editing you wish to perform.

3. From the Format list, choose the option you wish to edit. Format specifies the 
format and media of the original.

4. From the Scale list, choose the option that you wish to edit. 
(The sharpness performed on an image depends on the scale 
of the image).

5. For the selected Format/Scale category, edit the Sharpness controls. Refer to 
Sharpness Controls on page 119.

6. Edit the Sharpness controls for as many Format/Scale categories of the 
Sharpness table as needed. 

7. After editing, click Save to save changes in the Sharpness table. You can enter a 
new table name, or overwrite the existing table. The new/modified table 
includes all settings for all Format and Scale categories. 
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While previous chapters focused mainly on color transparencies, this chapter 
describes other types of originals. The basic scan procedure is described in Basic 
Scan on page 35 and the image editing functions are described in Chapters 5-9. 
However, additional scan modes are available for special purposes and other types 
of originals.

Note:  Use Save Settings when defining special workflows. Then use Load Settings when 
you want to use one of these workflows.

Refer to Save/Load Setting on page 155 for more information.
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16-bit/8-bit Direct Scan
Scanning images in the Direct Scan workflow accelerates scanning time by allowing 
you to send images to final scan without the need to crop them. Therefore, the 
whole area around the transparencies is scanned. By defining the Direct Scan margin, 
you can eliminate the black frame for the purpose of image analysis only.

To scan images in the Direct Scan workflow, do the following:

1. From the Setup menu, point to General Preferences, and select Operation 
Modes. 

2. In the Operation Modes Preferences dialog box, enter a value in the Direct Scan 
Margin box, and click OK.

3. In the Layout display, select the location of the images you want to scan.

4. Define the scanning parameters in the Setup dialog box, and click Direct Scan. 
An inner blue frame is displayed on those windows that you selected in the 
Layout display.

5. In the Layout display, select the windows you want to scan, and click the Scan 
icon in the Windows palette.

In the Save Scan As window that is displayed, specify the folder where you want to 
save the files, enter a file name, and select a file format. 

Note:  Use the Prefix/Suffix option to set the file name in advance.

Note:  In the Scan dialog box, when scanning more than one file, you enter a file name, 
and the application automatically adds a sequential numbering to each final scan. For 
example, if you enter a name ‘Job’, the final scans will be saved as follows: Job_1 Job_2 
Job_3, etc.
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16-bit RGB 
Color RGB 16-bit mode enables you to output an RGB color space such as Adobe 
1998 and ProFoto.

.

If you select this mode, the color correction and LS curve options are unavailable.

To perform color corrections in this mode:

1. In the Input Profile box, select the profile @Transparency_iQsmart.

2. In the Output Profile box, select None.

3. Make the color corrections and then save the new input profile.

4. Select the output profile.
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16-bit B/W Mode
16-bit B/W is a new scanning mode for scanning B/W images, as well as RGB 
images, that addresses the ever-increasing need for archival of analog images as 
digital media. Many analog originals are historical black-and-white negative images. 
To ensure that these images are preserved digitally, the maximum amount of image 
information must be captured in digital form.

1. From the Mode list, select B&W 16 bit.

2. From the Input Profile list, select Gamma 1.8 or Gamma 2.2..
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Color Negatives
Scanning negative originals requires special considerations because negatives have 
a built-in orange color layer, and the tones and colors are reversed. For example, light 
areas appear dark and red appears cyan.

When scanning positives, you can achieve a good representation of your original. 
When scanning negatives, by choosing a proper device link and a film type table in 
the Setup dialog box, you can achieve, on the screen, a good representation of what 
the image will look like when printed in an RGB/CMYK device. Any device link used 
for positives can be used also for negatives.

In the Setup dialog box, select Negative under Media. Then choose a filmtype 
table that best suits your film type, and a device link that is a link between the 
color space of your scanner and output device.

Negative Balance is a function designed specifically for color negatives. During 
preview or final scan, the scanner automatically adjusts the color balancing 
according to the film type. See details below.

Using Negative Balance
In the Setup dialog box in Setup mode, when Media is set to Negative, Filmtype 
appears in the dialog box with the default Filmtype table N_Default@. The 
application is supplied with additional tables, suited for various types of film.

1. In the Setup dialog box, choose the Filmtype table suitable for your film type. If 
your film type is unknown or does not exist in the Filmtype list, choose 
N_Default@. Then click Apply. 

2. If necessary, edit the end points using the End Points function 
(see End Points on page 81).

Note:  In the End Points dialog box, Neutralize and Remove Cast are inactive.

Note:  End Points editing should be performed after applying the Filmtype table. See 
Filmtype and End Points on page 134.
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Under standard conditions, applying the correct Filmtype table is sufficient. 
However, for non-standard conditions, you might need to manually balance the 
image, as described below.

1. Click the End Point icon in the Image palette. The Negative Balance dialog box is 
displayed.

2. Using the picker, mark a reference point on the image. For example, mark a point 
that should be neutral. The Before color and CMY values are shown.

3. From the Adjust pop-up list, choose Global, Highlight, Midtone or Shadow, 
depending on the scope of your change:

• Choose Global if you want to change the entire image (Neutralize is active), 
or

• Choose Highlight, Midtone or Shadow to limit the change to 
a selected tone range (Neutralize is inactive).

See Image Correction Examples, Figs. 35 & 36: Using Neutralize.

4. For Global change:

• Click Neutralize to neutralize the image according to the reference point, 
or

• Modify the CMY values of the reference point using the CMY sliders. Maximum 
range is -30 to +30 of current value; each point has a specific range for each 
separation.

See Image Correction Examples, Figs. 37 & 38: Modifying skintone
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5. To change a selected tone range (Highlight, Midtone or Shadow), change the 
values of the relevant reference point using the CMY sliders (same as for 
Global, see above).

Note:  To obtain the desired results in local changes, the reference point and Adjust 
option must correspond. For example, choose the Highlight option if the reference 
point is in the highlights.

Tip:  Use the Sampler tool and Sample Points function to see the effect of your 
changes.

Option buttons in Negative Balance:

Tip:  Use the split screen feature to view the image before/after changes.

If additional changes are required, use other functions such as Gradation and Color 
Correction. 

See relevant sections in Tone Reproduction on page 79 and 
Color Editing on page 95.

Filmtype and End Points

Although End Points and Filmtype are independent functions, they are related. End 
Points editing is performed on the active Filmtype table, so you should apply the 
Filmtype table before editing the End Points. If you try to apply another Filmtype table 
after editing the End Points, the system prompts that End Points changes will be lost. 
However, you can edit the Filmtype table, without canceling the end points editing. In 
addition, when you save a Filmtype table, it includes the End Point balance.

Apply Active after each change, to update the image.

OK Updates the current image and exit the function. The 
Filmtype table becomes Custom.

Reset Last Cancels the last Apply, that is, the last change that was 
applied to the image.

Save Saves color balance in a Filmtype table.

Cancel Cancels applied changes.
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Printed Material
When you scan printed material, the printing dot pattern is sharpened thus creating 
unwanted effects called moiré. A slight amount of optical descreening can solve this 
problem by forcing the optics to move away from the focal plane, thus blurring the 
dot pattern without degrading the image.

Smooth - Descreening

Using descreening, controls the level of defocus to be effective during the scan. The 
results can be viewed in max detail prescan or in the final scan.

1. Choose a value from the Smooth pop-up list: Screen1 (very weak blurring) to 
Screen10 (very strong blurring). In None, descreening is inactive.

2. The required screening is a function of the screen ruling of the original. For low 
screen ruling (such as 80 LPI), more descreening is required (value 6 or 7). For 
high screen ruling (such as 150 LPI), less descreening is required (value 3 or 4).

3. Perform a max detail prescan.

For more information about Max detail, refer to Interactive Sharpness Editing on 
page 123.
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4. When a max detail prescan with descreening is completed, the queue is 
suspended. This enables you to immediately repeat the max detail with a new 
screening value, if so required.

5. To repeat the max detail, click Show in the Setup dialog box (Show is available 
after changing the screening value).

Refer to Image Correction Examples, Figs. 33 & 34: The dot pattern is blurred when 
using descreening

The system rescans the same max detail area, using the new screening value, 
and the new max detail display replaces the previous one.
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B&W Mode
If your image is in B&W, choose the B&W mode to create a B&W file. You can also 
create a B&W file from a color image, where all the image colors are taken into 
consideration. The final B&W file has only one separation.

Options specific to B&W mode

• Only B&W Device Links are available; default is BW_Default@.

• The black separation is the only display option.

• In Gradation, only the black separation control is active.

• Color Correction is inactive.

Final scan formats in B&W mode

• EPSF

• TIFF

• JPEG

The settings for the above formats are as in the color modes.
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Line-art Mode
In the Line-art mode, you can perform a high resolution line-art scan, where the 
created image has either black or white pixels.

Line-art options in Setup mode

1. In the Setup dialog box, select Line-art.

Note:  You cannot change to the Line-art mode after preview.

2. From the Format pop-up list, choose your format:

• for transparency, choose 8x10H, 8x18V, or All board.

• for reflective, choose A4H, A4V, or All board-A3.

Line-art controls include:

• Threshold value; based on the crop analysis, the application automatically 
defines the Threshold value and sets it at 50. The Threshold sets the distinction 
between the line-art image and its background. You can change the Threshold 
value, as described below (it is recommended to set the threshold in Max 
Detail).

• Filter; choose the filter to be used in the scan. For B&W originals, choose the 
green filter. For Color originals, choose the filter according to the colors you want 
to eliminate or emphasize. To eliminate a color, choose that filter (for example, 
to eliminate blue grids, choose the blue filter). To emphasize a color, choose 
another filter (for example, to emphasize red, choose the green or blue filter).
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1. Click the Line-art icon in the Image palette, 

or choose Line Art Threshold from the Image menu. The LineArt Control dialog 
box is displayed.

2. From the Filter menu, choose the Red, Green or Blue filter, according to the 
above guidelines.

3. Set the Threshold slider or enter a new value in the input box. 
The image changes interactively.

Line-art display options

Line-art display (for black and white pixels only).

B&W display (black, white and grays). This is useful when you want to see more 
details, for example, when cropping.

To choose the display option, click the Line-art or B&W icon on the left side of 
the Image display window.
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Sharpness

Using Sharpness improves the resolution of the fine details in the final high 
resolution line-art scan. Sharpness editing is similar to the methods used in color 
modes (described in Sharpness on page 117). However, the Sharpness table in line-art 
contains only one format - Line-art for the entire scale range, and only one 
sharpness control may be edited (see Intensity, below).

Note:  This dialog box is accessed from Sharp Setup - Line-art.

Intensity

Intensity is the single sharpness control in Line-art mode. It determines the extent 
of sharpness produced by the Sharpness function, relative to the background. 
Intensity ranges from 0 - No Sharp to 10 - Max Sharp. The recommended initial 
value is 4 for a normal good quality original.

Final scan formats in line-art

• TIFF

• EPSF

Note:  The DCS, ICS, Include HalfTone Screens and Include Transfer Function options are 
not active. The Preview Pict options are 1 Bit or None.
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Oil Mounting
The oil mounting station (Kodac patent pending) is a device for 
oil mounting of transparencies in flatbed scanning. In scanning transparencies, dust, 
scratched slide surface and other imperfections, such as Newton rings, lower the 
quality of the scans. Post-scanning correction of these imperfections (retouching) is 
an expensive and time-consuming process. In attempt to avoid correcting the 
imperfections post-scanning, oil mounting method is used. Oil fills 
the scratches and other surface imperfections in the transparencies providing a 
smooth surface and thus a better quality scan. For high quality scans, the oil 
mounting should be used in the following cases: 

• with enlargements above 600% in which case “craters” that normally exist on 
the slide surface appear as noise

• when the slide is scratched

• when you have Newton rings despite the special glass treated to eliminate 
Newton rings

Transparencies can be mounted directly on the scanner or using a transparency 
mounting mask. The mask is used to block the passage of light in areas that are not 
to be scanned. The mask also defines fixed positions for the transparencies enabling 
the scanning software to locate and, depending on the software, memorize the 
positions of the transparencies. The mask has pre-cut windows of various sizes to 
match the relevant transparencies. These windows allow the transparencies to be 
positioned at right angles.

The station for oil mounting of transparencies is designed to eliminate the 
drawbacks of the traditional oil mounting method by providing:

• clean and aesthetic oil mounting

• pre-scanning corrections

• maximum accuracy in positioning transparencies (station base grid lines or 
mask)

• high productivity by using additional base glass 
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Automatic Focusing of Reflective Scans
This feature improves the focus of originals that are not entirely flat, such as 3D 
objects. When this feature is selected, the scanner automatically detects the areas 
of the object located above the base glass and adjusts the focus accordingly.

To automatically focus a reflective scan:

In the Setup Dialog box, in the Type box, select Reflective and Auto.

.
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Producing a Gray Image From a Black-and-White or Color 
Original

To produce a gray image from a black-and-white or color original, you can use either 
of the following input profiles:

• Tr_iQ_Gray: For use with transparent originals

• Ref_iQ_Gray: For use with reflective originals

add:/Tr_Es_Gray

add:/Ref_ES_Gray

Note:  If you do not specify an output profile the RGB values will not be equal.
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Save Preview
The save preview feature enables you to save the preview of your scan as a low

resolution image for archiving or for use on the web. Any color definitions that you

set in the preview are saved in the low resolution preview.

1. Use the cropping tool to crop an area of the preview.

2. From the Scan menu, select Save Preview > Active Crop.

The cropped area is saved as a low resolution image. The image is the size of the 
cropped area.

.
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Recommended Workflow:

1. Preview all the required images.

2. In the Setup Dialog box, set the color mode parameters. For example:

• Mode: Color RGB 8 bit

• Output Profile: AdobeRGB1998.icc

3. Set the desired crop for each image.

4. Close the Preview window.

5. In the Preview Browser, select all the images for which you want to save a low 
resolution image.

6. From the Scan menu, select Save Preview > All Crops.

7. Give each preview a name and click Save.

A cropped area of each preview is saved as a low-resolution image..

Note:  When working with the save preview feature, do not perform any other action 
such as pre-scan, max details, or final scan.
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Output Simulation with CMYK Values
The output simulation feature now enables you to view the RGB or CMYK values in 
the selected CMYK or RGB profile while working in RGB mode. You can change RGB 
values and see your changes in CMYK. This addition to the output simulation 
feature is designed for working with CMYK

.

To view the CMYK values:

1. Select the Output Simulation check box.

2. In the output profiles list, select the desired output profile.

3. Click .

4. The CMYK values are displayed.
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Scanning Modes
Scanning modes offer you a choice among varying scanning combinations based on 
a balance between quality and speed.

This feature is only available in ES Supreme.

The available modes are:

• Accelerated for rapid scans.

• Standard produces an optimum balance between speed and quality.

• Excellent achieves the best image results. Excellent is further subdivided into High 
and Very High (quality) levels to give you full control.

From the General Preferences menu, choose Scanning Mode. 
The Scanning Mode dialog box is displayed.

With scanning modes you can control the balance between speed and quality. In the 
Standard mode, quality and speed are automatically optimized. By choosing 
Accelerated, you can increase the scan speed up to 30% with a minimum loss of 
quality. However, when the quality of the final image is very important, you can 
choose the Excellent Mode. The scan takes longer, but, because you reproduce more 
shadow detail and the scanned image has a larger dynamic range, you achieve 
optimum results. 

You can use a different scanning mode for each crop or review.
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Scan Margin

To ensure proper picture placement in your page-makeup application, you can add a 
scan margin to the scan size. The margin is then added to the final scan area. When 
the margin is set to 0, only the crop area is scanned.

Check the Scan Margin box, and enter a number in millimeters only. If you enter 
an inappropriate number, an error message is displayed.

Note:  A Warning icon appears when you scan the entire image in maximum scale 
and with a scan margin.

Display separation in color

Check this box to display the different separations in color. For example, to see the 
cyan separation in cyan or in B/W. If the box is checked, the cyan separation is 
shown in cyan. If not, it is shown 
in B/W.

Beep at end of process

The application beeps three times at the end of each preview, prescan and scan.

Expert Mode

Check this option if you want to access the options under Expert mode. See Expert 
Preferences on page 150. 

Service Mode

Intended for service engineers only.

Open Layout Display after Restart 

Check this option if you want the Layout display to automatically open upon 
application restart. The Layout display is described in Layout Display on page 45.

Ignore Automatic Focus Alert

When you scan 35-mm framed slides, the scanners automatically focuses on the 
transparencies. Sometimes, due to the details in the transparencies, the scanner 
fails to find the focus, and a message is displayed prompting you to ignore the 
automatic focus and use the default parameter. Check this option to ignore the 
message and to continue scanning with the default parameter.

Direct Scan Margin

In the Direct Scan Margin box, you can define the size of the margin you want the 
application to ignore when performing image analysis.

For more details, refer to 16-bit/8-bit Direct Scan on page 129. 
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Expert Preferences
The options under the Expert mode have wide-range effects. Therefore, they are 
recommended for site-management level only.

1. To access the Expert mode options, check the Expert Mode box in the Operation 
Modes dialog box, under the General Preferences (see Scan Margin on page 149). 

2. From the Setup menu, choose Expert Preferences, which is now active. The 
Expert mode options are described below.

Tone Reproduction
Tone Reproduction sets your preference for the contrast of the Tone Reproduction 
curve, for transparency/reflective and for the CMYK/RGB color modes. 



Expert Preferences 151

Choose Normal contrast or High contrast.

For CMYK, only Normal contrast is available.

For RGB, it is usually recommended to use High contrast. But 
if you intend to transform RGB to CMYK using the ResoLUT PS (PS/W) application, 
choose Normal contrast. 

Note:  The Color tables are based on normal contrast. Different tables are required for 
high contrast.

Auto Image Analysis
Auto Image Analysis is used to adjust the image analysis results before Preview, so 
that they suit your preferences. You can also change the default value for Remove 
Cast.

For further details, refer to Auto Image Analysis on page 151.

Interpolation Mode
Interpolation mode is an improvement for scanning originals of smooth, soft 
backgrounds.

To access the Interpolation mode:

• Select Interpolation Mode.

• Check the Smooth box (system default is Normal).

Sharp Setup

For extensive editing of Sharpness tables, refer to Sharp Setup on page 125.
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Separation Setup
To access the UCR, GCR and UCA functions. 

Densitometer Setup
The densitometer measures the color at the pointer’s current position on the 
displayed image, and displays its values in the Densitometer field, at the bottom left 
corner of the Image display window.

From the Setup menu, choose Densitometer Setup. 
The Densitometer Settings dialog box is displayed.

Densitometer mode: Input/Output

Click Input if you want the densitometer to measure input values, or click Output if 
you want the densitometer to measure output results. 

Units

For the selected densitometer mode, choose the units of measurement:

• For Input, choose Density or SysValues.

• For Output, choose SysValues, Percent, or Lab. 

Note:  For output, in the RGB Color mode, only Sys Values and Lab are available.

Sample Size

The sample size that the densitometer measures around the pointer. Default is 3x3, 
that is, the densitometer averages the density of nine pixels, three in height by three 
in width, around the pointer. Other size options: 1x1 and 5x5. 
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ICC Flow Setup
When you use ICC profiles, select ICC Flow Setup from the Setup menu to display 
the Rendering Intent dialog box. You can set a different rendering intent for reflectives 
and transparencies in RGB and CMYK modes.

The rendering intent determines how the color conversion is done from one color 
space to another. You can set a different rendering intent for reflective and 
transparent images both in RGB and CMYK.

For details on ICC workflow, refer to ICC Workflows on page 74.
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The four (4) Rendering Intent options are:

• Perceptual; the most common rendering intent used to achieve a good 
reproduction of the original; preserves the visual relationship between colors by 
shrinking the entire color space and by shifting all colors.

• Saturation; reproduces the saturated colors of an image into the color gamut of 
the output device.

• Relative Colorimetric; maps the colors that are out of gamut to the closest 
possible color within the gamut of the target color space, without effecting the 
colors that were inside the color space, those will remain as they were.

• Absolute Colorimetric; matches color exactly with no adjustment made for 
white point or black point that would alter the image’s brightness.

• Automatic; uses the default color translation included in the profile.

Clicking OK preserves the selected Rendering Intent, while clicking Cancel turns 
the application to its default, as in the Perceptual mode.
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Additional Settings
This section describes additional setting options in the Menu bar, that are not 
available in the Setup menu.

Save/Load Setting
A Setting file contains the parameter setting of the Setup dialog box and the setup 
options in the Menu bar. The saved Setting file can be loaded and used in a specific 
run. In this case, the Setup dialog box and setup options are set according to the 
loaded Setting file. 

To save a Custom table you must first save it under a different name.

To create a Setting file

1. From the File menu in Menu bar, choose Save Settings. 

2. In the dialog box that appears, assign a name to the file and click Save.

To load a Setting file

1. From the File menu in Menu bar, choose Load Settings.

2. In the dialog box that appears, choose the file and click Open. 

Windows Arrangement
The Window menu in Menu bar contains two options that can be used for arranging 
the various application windows and tools on your desktop.

Arrange Windows

When you choose Arrange Windows from the Window menu in Menu bar, the 
application rearranges the elements on your desktop according to a default system 
arrangement, or according to a saved arrangement. 

Save Arrangement

This option is useful when you want to arrange the application elements according 
to your preferences, and save this arrangement. Choose Save Arrangement from 
the Window menu in Menu bar to save the current arrangement. 

Note:  To restore the saved arrangement, choose Arrange Windows.
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<DRAFT book name>

Index

Symbols
<+> key,  124
<-> key,  124
<Control> key,  33
<Delete> key,  33,  52
<Option/Alt> key,  33
<Shift> key,  33,  50
<Tab> key,  33

Numerics
16-bit scan, in DT mode,  4
1x1,  152
2x35mm slide holder,  41
35 mm mask,  8
35 mm strip mask,  42
35mm,  41
35mm slide holder,  41
35-mm strip mask,  8
3x3,  152
4x5,  41
4x5 mask,  8
5x5,  152
6x6,  41
6x7,  41
6x7 mask,  8
8x10H/V,  41

A
activating crop,  52
active separations, specifying,  90
adjust, in Negative balance,  133
adjusting

automatic end point selection,  85
image analysis results,  85
scanning parameters,  44

advantages of
UCR/GCR,  112
user defined masks,  8

All Board,  41
All, filter option in Sharpness,  120
analysis, auto image,  85
anti-alias, in smoothening,  42
application

launching,  36
main features,  4

Apply
in Color correction,  101
in End points,  84
in Gray control,  109
in Input Gray levels,  111
in Negative Balance,  134
in Preview mode,  49

applying
Gradation tables,  87

Sharpness tables,  123
arrange windows,  155
assigning default name to crop,  49
Auto Image Analysis,  85,  151
auto naming, final scans,  50
AutoCustom,  86
automatic

adjustment, scanning parameters,  
44

resetting white point,  83

B
B/W

display, in Line-art mode,  29
mode,  137

background/foreground operation,  4
barcode,  9
basic hue control,  99
basic sharpness controls,  119
beep

after scan,  55
at end of process,  149

before/after update, comparing image,  
25

before/after values, CMYK,  99
Black Contrast,  108
Black Start Point,  108,  114
brightening/darkening image,  89
brightness, changing after Preview,  84
BW_Default@ table,  137

C
cast removal,  82
changing

brightness, Exposure control,  84
crop size,  26

clip, in Sharpness,  122
CMY Contrast,  108
CMY values,  133
CMYK

color separations,  31
controls,  99
mode, scanning using profiles,  76
values, changing,  100

color
balance, in negatives,  132
balance, in shadows,  112
corrections, performing,  100

color changes, defining effective range,  
100

Color Correction
icon,  32
mask,  104

color corrections
global,  96
performing,  100,  105
selective,  96

color negatives, scanning,  132
color palette

HSL,  99
in LS Curves,  102

color patches, CMYK before/after,  99
color separations, RGB/CMYK,  31
comparing image before/after update,  

25
contour

defining thickness,  121
determining extent,  121

contrast center, shifting,  90
control points, CMYK values of,  108
control, luminance/saturation,  99
controls

CMYK,  99
gradation,  90
keyboard,  33
separation,  90
sharpness,  119

creating
custom made ranges,  101
device link profile,  77
mirrored image,  43
Setting file,  155

crop
activating,  52
defining new,  27
deleting,  52
performing analysis,  49,  69
resetting,  28
resizing,  26
scaling,  27
scanning prescans,  55

crop parameters,  52
crop,

defining Full image,  49
cropping

prescan,  53
preview,  50

cropping tools,  25
current scan, editing sharpness in,  123
custom

layout format,  47
range settings, saving,  101

Custom, in Gradation,  87
customizing ranges,  101

D
dark point,  81

range, RGB values,  110
darkening/brightening image,  89
default crop name,  49
default system arrangement,  155
defining

contour thickness,  121
degree of smoothening,  119
grays,  107
scan parameters, final scan,  51
sharpening effect,  121
user defined formats,  11

defining color
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change range,  100
channel,  120

defining crop
Full image,  49
new,  27,  69
second crop,  51

defining new crop,  27
deleting

crops,  52
items from Scanner Queue,  22
user defined formats,  11

densitometer
setup,  152
with split screen,  31

density
in densitometer,  152

descreening
in smoothening,  42
with printed material,  135

desktop
schematic,  15
windows arrangement,  155

determining extent of contour,  121
Device Link profile,  43

in scanning negatives,  77
scan using,  77
with ICC workflow,  74

diagram, oXYgen workflow,  67
Digital archiving workflow,  66
direct

mount,  11
scan,  4,  68
scan, workflow,  129

display
CMYK,  31
options in Preview Browser,  16

display area,  25
display, Line-art,  29
displaying

all separation curves,  90
separations,  31
separations in color,  149

dot pattern, smoothening,  42
dpi (dots per inch),  43
dpm (dots per millimeter),  43
drawing new crop,  27
DT files

editing,  71
formats,  69
opening in EverSmart oXYgen Open,  

71
retouching,  70
scanning in oXYgen Scan,  68

DT mode, 16-bit scan,  4
Duplicate Crop option,  51

E
editing

DT files,  71
End Points,  82

functions,  5
Gradation tables,  88
preview, tools,  5
queue,  22
RGB values,  111
sharpness in current scan,  123

Effect levels, in Sharpnessl,  121
Effect, in Sharpness,  121
Effective Range, in color corrections,  108
embedding

ICC profiles,  72
input profile,  69
scanner profile,  74

end point selection, automatic adjusting,  
85

End Points
and Filmtype,  134
customize automatic selection,  86
editing,  82
exposure,  84
icon,  32
marker,  81
Save,  84
values,  84

End Points marker, showing/hiding,  30
End Points tables

saving,  86
End, gradation control,  91
enlarging originals,  43
entering application,  36
EPSF (Encapsulated PostScript File) 

format,  57
EverSmart oXYgen

opening DT files in Open application, 
 71

Expert mode,  149
Expert Preferences,  85
Exposure control, changing brightness,  

84
Extended option, in UCA,  115
extended sharpness controls,  120

F
features

Image palette,  31
main application,  4
multi-crop,  52

file formats,  57
in scanning DT files,  69

Filmtype
default table,  132
save table,  134

filter
in Line-art mode,  138
in Sharpness,  120

final scan
auto naming,  50
defining parameters,  51
formats in B&W mode,  137

fine hue control,  99

floating
densitometer,  31
Sample points,  28

foreground/background operation,  4
Format option, in Sharpness,  126
formats

for using ICC profiles,  56
layout,  40
output,  5
user defined,  11,  42

Full image crop,  26
Full image crop, defining,  49
functions

main editing,  5
tone reproduction,  80

G
G_Default@,  87
GCR (Gray Component Replacement),  

112,  152
general preferences,  148
global color corrections,  96
Gradation

dialog box, options,  91
tables, editing,  88

gradation
brightening/darkening image,  89
controls,  90
increasing/decreasing contrast,  89
shifting contrast center,  90
tables, applying,  87

Gradation icon,  32
grain, in Sharpness,  121
graphs, gradation,  89
gray

contol,  107
defining,  107
levels, input,  110
on RGB axis,  110

green filter, in Sharpness,  120
grouped items,  22

H
Hand pointer,  26
harsh effect, sharpness,  121
Hlt (Highlight), gradation control,  91,  121
horizontal handle,  25
HSL

color palette,  99
numeric input field,  99
sliders, in Range,  101
value ranges,  100

hue control,  99

I
ICC profiles,  153

embedding,  72
in basic scanning,  43

ICC workflows,  4,  74



Index 159

<DRAFT book name>

icons
in Scan palette,  19

image adjustment, parameters,  43
image analysis

adjusting,  85
before preview,  151
results, adjusting,  85

Image display window,  24
image editing,  55

color balance,  82
color changes,  96
global, in negative balance,  133

Image palette
features,  31
icons,  32

Include Grays option,  103
increasing/decreasing contrast,  89
indicators, active crop,  52
Ink Coverage,  114
Input gray levels,  110
input profile, embedding,  69
input size, in scaling,  27
input/output profiles,  74
inserting slides in slide holder,  9
intensity in Sharpness,  140
intensity, in Sharpness,  121
interactive editing

sampler,  28
split screen,  25

interactive sharpness editing,  123
interface, multi-level,  4
Interpolation mode,  151

J
jagged lines,  42
JPEG (Joint Photographic Experts Group)

format,  57

K
keyboard

controls,  33
shortcuts,  34

L
launching application,  36
Layout display,  11,  149

mix format mask,  46
using,  45

layout formats,  40
updating/saving,  47

Line-art
control dialog box,  139
display options,  29,  139
final formats,  140
icon,  32
mode,  138
sharpness,  140

load settings,  155
low resolution

scan, preview,  48
LS Curves

graph,  103
icon,  32
modifying,  102

luminance/saturation,  99
ranges control,  103

luminance/saturation controls
in LS curves,  103

M
main editing functions,  5
main features,  4
marker, End Points,  81
marking reference point,  109
mask registration holes,  10
mask, mix format,  8
masks

mix format,  8,  42
supplied,  8
user defined,  8

Max Detail
in Line-art,  138
performing,  28,  123

Maximum Black,  114
measurement units,  42
Media

in Preview mode,  49,  69
negative,  42
positive,  42

med-Smooth effect, sharpness,  121
Mid (Midtones), gradation control,  91
midtone range, RGB values,  110
minimum

output resolution,  43
mirrored image, creating,  43
mix format mask,  8,  42

in Layout display,  46
mode

and display,  31
B/W,  137
in Gray control,  107
in Preview mode,  49
Line-art,  138
printer RGB,  75
RGB color space,  75
scanner RGB,  74
Setup,  38

modes
scanning,  40

modifying
gray balance,  107
LS curves,  102

mounting
originals directly,  11
reflectives on mask,  10
transparencies on mask,  9

mounting originals,  4,  8
multi preview, direct mount,  12
multi-crop,  5

multi-crop features,  52
Multi-prescan icon,  19
multi-preview,  5
Multi-scan icon,  19

N
N_Default@, default filmtype table,  132
negative balance

global change,  133
using,  132

negative media,  42
negative originals, scanning,  132
Neutralize, in negatives,  133
neutralizing image,  83
new crop, defining,  27,  69
non-standard format originals, mounting, 

 11
numeric input field, HSL,  99

O
Old Ink,  114
opening

DT files,  71
optical descreening,  135
option, Direct Scan,  68
options in Gradation dialog box,  91
originals

direct mount,  11
mounting,  4,  8
non-standard format,  11
scaling,  43
types,  39

output
formats,  5
resolution, minimum,  43
simulation,  76
size, in scaling,  27

oXYgen
workflow, diagram,  67

oXYgen Scan, scanning DT files in,  68

P
parameters

crop,  52
image adjustment,  43
in Scan dialog box,  56

percent in densitometer,  152
percentage, gray component,  114
performing

color corrections,  100,  105
crop analysis,  49,  69
max detail,  28,  123
preview,  48

Photoshop
icon,  19

pixel variation,  121
positive media,  42
prefix/suffix function, using,  50
preparing user defined masks,  9
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Prescan icon,  19
prescan, cropping,  53
Preview

editing tools,  5
icon,  19,  48
mode,  49

preview
cropping,  50
in display area,  25
low resolution scan,  48
scanning,  55,  69

Preview Browser
display options,  16
using,  16

printed material, scanning,  135
Printer RGB mode,  75
priority, in Scanner Queue window,  21
processing preview, indicator,  48
profiles

Device Link in scanning,  77
Device Link with ICC workflows,  74
ICC,  43

progress indicator,  21,  48

Q
queue

item,  21
order,  21

Queue window,  124

R
radius, in Sharpness,  121
range

clip,  122
color changes,  100
customizing,  101
in color correction,  100

Ranges control, for luminance/
saturation,  103

red-green filter, in Sharpness,  120
reducing grain sharpness,  121
reference point, marking,  109
reflective originals, options,  39
reflectives, mounting on mask,  10
registration holes,  10
removing cast,  83,  86
Reset

in Gray control,  109
in LS curves,  103

Reset All,  84
Reset crop,  27
Reset Last

in Color correction,  101
in Negative Balance,  134

resetting
crop,  28
white point,  83

resizing crop,  26
Restart icon,  19

retouching DT files,  70
RGB

axis,  110
color separations,  31
slider,  110
values, editing,  111

RGB color space
mode,  75

RGB mode, scanning images using 
profiles,  74

S
S_Default@ table,  123
Sample points

dialog box,  28
floating,  28
showing/hiding,  29

sample size, in densitometer,  152
sampler, for interactive editing,  28
sampling tools,  25
saturation/luminance control,  99
Save Arrangement,  155
Save Params for Scan option,  55
Save Settings,  155
saving

custom Range settings,  101
End Points tables,  86
Sharpness table,  126
user defined formats,  53

saving/updating layout format,  47
scaling,  27
scaling originals,  43
Scan dialog box, parameters,  56
Scan icon,  19
scan items, selecting,  55
Scan Margin,  149
Scan Once Output Many (SOOM) 

workflow,  66
Scan palette, icons,  19
scanner

profile, embedding,  74
RGB mode,  74

Scanner Queue window, deleting items,  
22

scanning
crop prescans,  55
DT files, in oXYgen Scan,  68
formats,  40
in CMYK mode using profiles,  76
in Direct Scan workflow,  129
in RGB mode using profiles,  74
negative originals,  132
negatives, using Device Link profiles,  

77
preview,  55
printed material,  135
thick reflectives,  11
types of original,  39
types of originals,  128
using Device Link profile,  77

scanning formats, using ICC profiles,  56
scanning media,  42
scanning modes,  40,  148
scanning parameters, automatic, 

adjustment,  44
scanning preview,  69
Scitex ResoLUT PS (PS/W),  151
second crop, defining,  51
selecting

items for scan,  55
selective color corrections,  96
separation

controls,  90
curves, display all,  90
curves, in Gray control,  107
curves, in UCR/GCR,  114
setup,  112

separations, displaying,  31
Service mode,  149
setting

enlargement for final scan,  27
resolution,  43
white density,  83
white point,  83

Setting file, creating,  155
setting up

separations,  112
Setup dialog box

parameters,  39
Warning icon,  51

Setup mode,  38
setup parameters,  39
sharp effects, showing/hiding,  30
sharpening effect, defining,  121
Sharpness

basic controls,  119
create table,  125
editing in max detail,  125
editing, interactive,  123
function,  118
icon,  32
in Line-art,  140
med-Smooth effect,  121

Sharpness tables
applying,  123
saving,  126

Shd (Shadows), gradation control,  91
Shd, in Sharpness,  121
shortcuts, keyboard,  34
Show All icon,  16
Show End Points icon,  81
Show Previews icon,  17
showing

current/after values,  84
End Points,  81

showing/hiding
End Points marker,  30
sample points,  28,  29
sharp effects,  30

simulation, output,  76
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single preview, direct mount,  11
slide holder, for transparencies,  9
SmartSet tables, using,  44
smoothening

defining degree,  119
effects,  124
options,  42

SOOM (Scan Once Output Many) 
workflow,  66

specifying active separations,  90
split screen, in interactive editing,  25
split workflow,  66
start point, in UCA,  115
Strength option, in UCA,  115
Strip 80 mm,  41
Strt (Start) option, in Gradation,  90
supplied masks,  8
system arrangement, default,  155
SysValues in densitometer,  152

T
Tab key,  52
tables

gradation,  87
thick reflectives, scanning,  11
threshold

in Grain control,  121
in Line-art mode,  138

TIFF (Tagged Image File)
format,  57

tone reproduction, functions,  80
tools

cropping,  25
editing preview,  5
sampling,  25

transparent originals
mounting on mask,  9
options,  39

two-point method, in scaling,  27
type, original,  39

U
U, G, A indicators,  25
UCA (Under Color Addition),  112
UCR (Under Color Removal),  112,  152
UCR/GCR

advantages,  112
separtion curves,  114

units
in densitometer,  152
measurement,  42

updating/saving layout format,  47
user defined formats

defining,  11,  42
saving,  53

user defined masks
advantages,  8
preparing,  9

user interface, multi-level,  4

using UCA (Under Color Addition),  114

V
Value option, in Grain,  121
value ranges, HSL,  100
values, showing current/after,  84
vertical handle,  25
viewing color corrections,  104

W
Warning icon, in Setup dialog box,  51
white density, setting,  83
white point,  81

manual selection,  83
range, RGB values,  110
resert automatically,  83
RGB values,  110
setting,  83

White/Dark point, controls,  82
Windows palette,  23
workflow

Digital archiving,  66
Direct Scan,  129
ICC,  4,  74
oXYgen,  67
SOOM,  66

working with DT files, in oXYgen Open,  
71
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